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InnoVision Technology Program License Agreement

READ THE TERMS AND CONDITIONS OF THIS LICENSE 
AGREEMENT CAREFULLY BEFORE OPENING THE  
PACKAGE CONTAINING THE PROGRAM DISKETTES, THE 
COMPUTER SOFTWARE THEREIN, AND THE  
ACCOMPANYING USER DOCUMENTATION (THE 
"PROGRAM"). THIS LICENSE AGREEMENT REPRESENTS  
THE ENTIRE AGREEMENT CONCERNING THE PROGRAM  
BETWEEN YOU AND INNOVISION TECHNOLOGY, AND IT 
SUPERSEDES ANY PRIOR PROPOSAL, REPRESENTATION, 
OR UNDERSTANDING BETWEEN PARTIES. BY OPENING  
THE PACKAGE CONTAINING THE PROGRAM, YOU ARE 
ACCEPTING AND AGREEING TO THE TERMS OF THIS  
LICENSE AGREEMENT. IF YOU ARE NOT WILLING TO BE 
BOUND BY THE TERMS OF THIS AGREEMENT, YOU 
SHOULD PROMPTLY RETURN THE PACKAGE UNOPENED, 
AND YOU WILL RECEIVE A REFUND FOR 
YOUR MONEY.

1. LICENSE GRANT. InnoVision Technology hereby grants to 
you, and you accept, a non-exclusive license to use the Program 
Diskettes and the computer software contained therein in 
object-code-only form, and the accompanying User 
Documentation, only as authorized in this License Agreement. 
The Software may be used only on a single computer owned, 
leased, or otherwise controlled by you: or in the event of the 
inoperability of that computer, on a backup computer selected by 
you. Neither concurrent use on two or more computers nor use 
in a local area network or other network is authorized without the 
advance written consent of InnoVision Technology and the 
payment of additional license fees.

YOU AGREE THAT YOU WILL NOT ASSIGN, SUBLICENSE, 
TRANSFER, PLEDGE, LEASE, RENT, OR SHARE YOUR  
RIGHTS UNDER THIS LICENSE AGREEMENT.

IF YOU TRANSFER POSSESSION OF ANY COPY, 
MODIFICATION OR MERGED PORTION OF THE PROGRAM 
TO ANOTHER PARTY, YOUR LICENSE IS AUTOMATICALLY 
TERMINATED

Upon loading the Software into your computer, you may retain 
the Program Diskettes for backup purposes. In addition, you may 
make one copy of the Program on a second set of diskettes for 
the purpose of backup in the event that the Program Diskettes 
are damaged or destroyed. Any such copies of the Program 
Diskette shall include InnoVision Technology’s copyright and 
other proprietary notices. Except as authorized under this 
paragraph, no copies of the Program, its documentation, or any 
portions thereof may be made by you or any person under your 
authority or control.

2. LICENSOR'S RIGHTS. You acknowledge and agree that the 
Program consists of proprietary, unpublished products of 
InnoVision Technology, protected under U.S. copyright law, and 
trade secret laws of general applicability. You further 
acknowledge and agree that all right, title, and interest in and to 
the Program are and shall remain with InnoVision Technology. 
This License Agreement does not convey to you an interest in or 
to the Program, but only a limited right of use revokable in 
accordance with the terms of the License Agreement.

3. TERM. This License Agreement is effective upon your 
opening of this package and shall continue until terminated. You 
may terminate this License Agreement at any time by returning 
the Program and all copies thereof and extracts therefrom to 
Licensor. InnoVision Technology may terminate this License 
Agreement upon the breach by you of any term hereof. Upon 
such termination by InnoVision Technology, you agree to return 
to InnoVision Technology the Program and all copies and 
portions thereof.

4. LIMITED WARRANTY. THE PROGRAM IS PROVIDED "AS 
IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED 
TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK 
AS TO THE QUALITY AND PERFORMANCE OF THE  
PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE 
DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION.

SOME STATES DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY 
NOT APPLY TO YOU. THIS WARRANTY GIVES YOU  
SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE 
OTHER RIGHTS WHICH VARY FROM STATE TO STATE.

InnoVision Technology does not warrant that the functions 
contained in the Program will meet your requirements or that the 
operation of the Program will be uninterrupted or error free. 
However, InnoVision Technology warrants the diskette(s) on 
which the program is furnished, to be free from defects in 
materials and workmanship under normal use for a period of (90) 
days from the date of delivery to you as evidenced by a copy of 
your receipt.

5. LIMITATION OF LIABILITY. IN NO EVENT SHALL 
INNOVISION BE LIABLE FOR ANY INDIRECT, INCIDENTAL, 
CONSEQUENTIAL, SPECIAL, OR EXEMPLARY DAMAGES OR 
LOST PROFITS ARISING OUT OF THE USE OR INABILITY TO 
USE SUCH PROGRAMS EVEN IF INNOVISION TECHNOLOGY  
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.

6. GOVERNING LAW. This License Agreement shall be 
construed and governed in accordance with the laws of the State 
of California.

7. ACKNOWLEDGEMENT. YOU ACKNOWLEDGE THAT YOU 
HAVE READ THIS LICENSE AGREEMENT, UNDERSTAND IT, 
AND AGREE TO BE BOUND BY ITS TERMS AND 
CONDITIONS. YOU ALSO AGREE THAT THIS SUPERSEDES 
ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR 
WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN 
THE PARTIES RELATING TO THE SUBJECT MATTER OF 
THIS AGREEMENT.

Should you have any questions concealing this Agreement, 
please contact in writing InnoVision Technology.



BROADCAST TITLER 2 ADDENDUM
OCTOBER 19,1990

PLAYING THE PROVIDED DEMO DISK SEQUENCE

The Demo Disk included with the program requires at least 2 megabytes of RAM to 
accommodate the extended demo sequence on the disk. The extra memory is required because 
the provided demo sequence contains several IFF pictures, extra fonts and sample pages showing 
the new Super High Res video mode. This special sequence requires at least 2 megabytes 
because of the associated memory demands.

However, you can still place your own sequences on a copy of the demo disk to create 
auto-booting sequences that will play on any machine having the minimum 1.5 megabyte 
configuration.

PREVENTING TAPE DECKS FROM LOCKING-UP THE AMIGA

Using the fast shuttle search or rewind functions on professional tape decks can sometimes 
completely lock-up or freeze the Amiga while you are editing. When this occurs, the Amiga 
hardware itself cannot maintain proper video sync during fast tape shuttling operations, and can 
cause any software running at the time to appear to freeze as a result. This problem is 
hardware-related and may or may not occur in your setup, depending on the specific Amiga 
model, genlock and tape equipment you are using.

Broadcast Titler 2 provides an special feature to prevent this from happening on your system.

1) Enter the Text Edit Mode and press function key F10 to activate the "shuttle safeguard" 
feature

2 Now you can safel shuttle to the next edit point on your source tape without risking a system 
freeze.

3 Then click either mouse button or press any key from the keyboard to resume your normal 
sditin and playback operat'ons.
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INTERNATIONAL ACCENTED CHARACTERS

Two of the standard Broadcast Titler fonts provided with the NTSC version contain the full set of 
international accented characters. The Swiss_50 and Minerva_50 contain the full ASCII 256 
character set, while the other NTSC fonts only contain the first 191 characters (which contain the 
special symbols such as ©, ® ,, etc., but do not contain the character accents such as 6).

The international accents require considerably more space in resident font memory, and are only 
included in these two fonts so that Broadcast Titler will run on a 1.5 megabyte Amiga.

THE STANDARD NTSC FONT LIST

The standard Broadcast Titler fonts for the PAL version of the program are listed on page 96 of 
the User’s Guide. The NTSC version contains a slightly different set of fonts, specifically with a 
larger size of the Holiday font than is provided with the PAL version.

For the NTSC version the BTFONTS.LOAD file contains the following fonts, listed in order of 
occurrence:

Swiss_50.btf, Swiss_67.btf, Swiss_37.btf, Swiss_25.btf, Swiss_15.btf, Minerva_67.btf, 
Minerva_50.btf, Minerva_37.btf, Minerva_25.btf, Minerva_15.btf, Sports_80.btf, Sports_40.btf, 
Sports_20.btf, Holiday_70.btf, Holiday_35.btf, Swiss_100.btf

SAVING A PAGE AS AN IFF PICTURE

A new feature has been added so that Broadcast Titler pages are now saved with full 
Anti-aliasing. The description of this function on page 93 should be changed to reflect that 
character anti-aliasing IS preserved in the saved IFF picture file.
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Broadcast Tiller
Professional character generation comes to the Amiga with 
Broadcast Titler! Included fonts contain four level anti* 
aliasing which matches the quality of character generators 
costing thousands more. Use S tandard / Color Amiga fonts to 
expand the Broadcast T itler font lib rary . Screens may con­
tain up to 320 colors. Includes many broadcast quality line 
and page effects.

Broadcast Font Enhancer
Bring additional super crisp fonts into Broadcast T itler by 
enhancing standard  Amiga fonts with four level anti-aliasing. 
Accurately reduces large fonts to get that exact size you want, 
while preserving original detail.
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Each font pack includes broadcast quality fonts and symbols. 
These fonts are in both Broadcast T itler anti-aliased form at 
and standard  Amiga form at. Each font pack contains care­
fully selected fonts similar to those seen in actual broadcasts.
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W ith Super P rom pt, professional teleprom pting is affordable. 
Use the powerful text editor included within Super Prom pt, 
or any other word processor, to enter your scripts and away 
you go! User friendly features like colorful menus, large 
typefaces, and quick keystrokes make teleprom pting quick 
and easy. Ideal for both the am ateur and the professional.

Video Effects
Convert two dimensional pictures into three dimensional 
animations! Powerful routines produce super smooth anim a­
tion at sixty fields a second. Two dimensional objects can be 
automatically extruded into 3D without any knowledge of 
three dimensional modeling. Digital video effects are now just 
a mouse click away!
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PROFESSIONAL VIDEO SOLUTIONS FROM INNOVISION TECHNOLOGY

BROADCAST TITLER 2 Broadcast Quality Video Character Generator

□  Convenient Mouse or Keyboard-driven Interface.
□  On-Line Storage for up to 600 Pages of Text and Graphics.
□  Includes 16 Anti-aliased fonts, 4 attractive styles.
□  Accepts Hundreds of Amiga Fonts and Color Fonts., up to 50 RAM Resident Fonts at a Time.
O Character Attributes include Outline, Highlight, Underline, Solid and Cast Shadows in 8 Directions.
□  Intermix Multiple Fonts, Sizes and Colors on any Line.
□  Up to 320 Colors per Screen in High Resolution, 16 Colors per Line.
□  Full Overscan Display eliminates Video Borders (736 x 480 pixels).
□  Silky Smooth Page and Line Transitions: ROLL, CRAWL, FLIP, WIPES, TELETYPE, many others.
□  Random Access, GPI or Continuous Playback, nine effect speeds.
□  Requires Amiga computer with 1.5 Megabytes of Memory, one Disk Drive.

BROADCAST TITLER 2 FONT ENHANCER Enhancer for Standard Amiga Fonts REQUIRES
BROADCAST TITLER 2

O Converts Standard 1 Color Amiga Fonts to Broadcast Titler’s Anti-aliased format.
O Accurately Resizes fonts to smaller sizes while preserving original detail.
O Dramatically Improves Amiga Font resolution by adding four-level Anti-aliasing.
□  Resulting Fonts occupy five times less memory, allowing many more resident fonts.
□  Customize Fonts or Logos in other Font Editing Programs, Anti-alias them with the Font Enhancer.

BROADCAST FONT PACK 1 High Quality Amiga and Broadcast Tltler 2 Fonts

□  Mathematically correct font design yields stylish, professional quality typefaces.
□  All fonts are in both Anti-aliased Broadcast Titler 2 and Standard Amiga Font formats.
□  Standard Amiga Fonts can be used by other graphics/desktop publishing programs.
□  10 Font styles in Multiple Sizes up to 160 Scanlines high.
□  Create additional sizes for Broadcast Titler 2 with Font Enhancer (Above).

SUPER PROMPT Professional Video Teleprompter

□  Use Super Prompt’s text editor to quickly enter text for scrolling, or load in ASCII text files from other
Amiga word processors.

□  Scroll Text at 10 different speeds, adjustable on-the-fly.
□  Includes 10 programmable director’s prompt messages to flash cues on screen.
□  Hard copy output of scripts in large graphic format or as regular text.
□  Three Font Sizes to choose from.
□  Requires 1 Megabyte of Memory, 1 Disk Drive.

VIDEO EFFECTS 3D Generates Exceptional Animations And Special Effects

□  Manipulates 8 Color High Resolution Pictures from Amiga Paint/Graphics Packages.
□  High Resolution 704 x 480 pixel overscan display.
□  3D Perspective WIPES, TUMBLES, TURNS, FLIPS, SPINS, ZOOMS and FLY IN effects.
□  Super Smooth playback at 60 Fields per Second.
□  Extrude 2D IFF Pictures to 3D Objects without experience in 3D Modeling.
□  Creates unlimited effect combinations.
□  Effects can be genlocked over a video background.
□  Convenient on screen instructions make operation quick and easy.
□  Requires 1 Megabyte of Memory (1.5 Recommended), 2 Disk Drives or Hard Drive, IFF Pictures.
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COPYRIGHT NOTICE

This software package and document are copyrighted -1990 by InnoVision Technology. All 
rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored 
in any retrieval system, or translated into any language by arty means without the express written 
permission of:

InnoVision Technology 
1933 Davis Street 
Suite 238
San Leandro, CA 94577 
U.S.A.

415-638-8432
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Disclaimer

Innovision Technology makes no warranties as to the contents of this software product and 
disclaims any implied warranties of merchantability or fitness for any particular purpose. 
InnoVision Technology reserves the right to make changes to the specifications of the program 
and contents of the manual without obligation to notify any person or organization of such 
changes.

Amiga is a trademark of Commodore Business Machines Inc. 
Broadcast Titler 2 Copyright 1990 InnoVision Technology. 
Calligrapher Font Editor is a trademark of Inter Active Softworks. 
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I INTRODUCTION

InnoVision Technology is happy to announce the second generation of its desktop video 
character generator package for the Amiga, Broadcast Titler 2.

Broadcast Titler 2 is a powerful Amiga-based Character Generator that combines the high-end 
functionality of dedicated video production equipment with the flexibility and cost-effectiveness 
of Amiga Desktop Video Systems. Sharp looking anti-aliased fonts, eye catching special effects, 
plus convenient editing and layout functions let you compose title sequences quickly and 
creatively.

The use of existing Amiga/Color fonts such as the Kara Fonts package and the Masterpiece Fonts 
package gives you a wide variety of fonts to choose from. User-created typefaces from an 
Amiga font editor, such as Interactive Softworks’ Calligrapher, can also be used in Broadcast 
Titler. Using the optional Broadcast Titler Font Enhancer, these fonts may also be converted into 
anti-aliased fonts to remove the "jaggies" seen in the high resolution 70 nanosecond graphics 
mode.

Each text line in Broadcast Titler can have its own adjustable 16 color palette. As many as 20 
lines per screen can be displayed, thus allowing up to 320 direct colors per screen. This feature 
allows you to break the 16 color per screen limit found in the high resolution mode of the Amiga.

SYSTEM REQUIREMENTS

An Amiga computer with at least 1.5 megabytes of RAM. For additional fonts and pictures, at 
least 2 megabytes of RAM is recommended, as well as a second floppy drive or hard disk.

MULTITASKING

Broadcast Titler 2 has been designed to take maximum advantage of the Amiga’s sophisticated 
graphics hardware. But in order to do this it was necessary for the program to take full control 
over the Amiga’s hardware, temporarily disabling normal operation of Amiga Intuition (CLI and 
Workbench) and multitasking.

If you have other programs running in memory, Broadcast Titler may fail to boot. We believe 
that multitasking is important, but in order for our transitions to be as smooth as possible we 
need as much horsepower as the Amiga can provide.
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REGISTRATION

Be sure to fill in and mail the enclosed registration card as soon as possible to qualify for 
Technical Support, future updates, and other important information.

GENLOCKS

Broadcast Titler has its own built in SuperGen fade effects that are controlled automatically by 
the Broadcast Titler program. It is not necessary to load the SuperGen’s own software drivers 
before running Broadcast Titler.

Commodore A2300 Genlock Users: You should be aware that the A2300 Genlock operates 
differently from any other genlock on the market in terms of its treatment of video sync and 
overscan. As a result of these differences, it shifts the Amiga video display down the screen by 
about six scanlines. In addition, it interferes with the normal video timing of the Amiga system. 
This is especially evident when you supply incoming video.

If you find that supplying video to the A2300 causes Broadcast Titler’s menus to become 
non-interlaced or unreadable, you can restore proper video timing by pressing CTRL "G" in the 
Main Menu. This is necessary only for the A2300 Genlock, and does not apply to any other 
genlock brand.

RAM DISKS

Although it might be possible to run Broadcast Titler from a RAM disk, there would be no 
advantage in doing so because Broadcast Titler keeps all pages, fonts and graphics entirely in 
RAM. It is recommended that you do not run Broadcast Titler using a RAM disk.

COPY PROTECTION

We have decided not to institute any copy protection procedures on Broadcast Titler, but we 
strongly advise you to always work from a backup copy. Distributing this software, or anyone 
else’s work, eliminates a possible customer which will then reduce the resources needed to 
provide adequate support and future updates. In other words, PLEASE do not distribute this 
software.

USING FLOPPY DISKS

Always wait until all disk drives are inactive before ejecting a disk, resetting the Amiga, or 
turning the power off. It is a good idea to keep a few blank formatted disks around for storing 
your work. It is recommended that you save your work often to prevent any accidental loss of 
data.

2
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WHAT DOES BROADCAST TITLER 2 DO?

Broadcast Titler 2 performs most of the functions of a dedicated video character generator. With 
this program, the user can create and edit one hundred or more pages of text and user-created 
graphics. All pages, graphics, and fonts are held in resident memory for quick retrieval, and can 
be loaded and saved on disk for later use.

The program takes full advantage of the Amiga’s powerful graphics and video chips to create 
smooth, eye-catching special effects. Each page or line can be assigned a separate transition 
effect with selectable speed and delay controls. The program also uses the hardware to extend 
the maximum number of on-screen colors from 16 to 320 colors via line-by-line palette controls.

Type and edit pages of text using the sharp-looking anti-aliased fonts included with the package. 
Standard sizes range from 100 scanline "banner-size" fonts down to miniature 15 scanline 
"disclaimer" fonts.

You can access additional fonts by using the Font Converter package which is included with the 
program. The Font Converter allows Broadcast Titler to use hundreds of commercially available 
Amiga Fonts and Color Fonts (multi-color pattern fonts) in high resolution, with sizes ranging 
from 15 to 200 scanlines in height.

If you purchase the optional Font Enhancer package, you can add Broadcast Titler’s four-level 
anti-aliasing to these fonts. You’ll also be able to resize the font to any smaller size from 12 to 
200 scanlines, without sacrificing font quality. This feature can be quite useful for making 
multiple sizes from a single large Amiga Font.

The program provides many text editing features such as cut and paste, adjustable margins, 
automatic and manual kerning, character spacing, centering and tab stops. Font style, size, color 
and border options can be changed on a character-by-character basis. Attributes can easily be 
picked-up and planted via keystroke commands. Text can be accurately repositioned on the 
screen anytime, even after you have already laid down your text.

FEATURES NEW TO BROADCAST TITLER 2

The Broadcast Titler 2 character generator software has been revised to include many new 
features not found in the original version.

All of the menus in the original Broadcast Titler have been either consolidated or revised to
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provide easy access to everyday functions. New menus such as the Page and Layout Menus 
provide the user with a high degree of control for editing and formatting pages and sequences.

Broadcast Titler 2 now incorporates a mouse-driven menu interface, which lets you make 
changes more quickly and with a lot less effort.

The program has been developed using the latest optimizing compilers and efficient assembly 
code in order to obtain top performance from the Amiga. All this translates into a program with 
better features and improvements in both speed and dependability.

NEW INTERFACE FEATURES

• Mouse and/or Keyboard menu operation
• Change Numbers via mouse/keyboard inputs
• Easy to Use Consolidated Menus
• Support for GPI (General Purpose Interface) activation
• Comprehensive User Guide and Tutorials

NEW EDITING CONTROLS

• Full Margin and Layout Controls
• Cut and Paste for Lines and Pages
• RGB and HS V palette slider controls
• Place Text virtually anywhere on screen
• Reposition Text even after it has been typed
• More precise Auto Kerning, Tuck and Space
• Page Menu shows entire Sequence for quick editing
• New Sequence Append

EXPANDED CAPABILITIES

• Automatic Pattern Filled Text from IFF Brushes
• New Character Borders
• Sharper Anti-aliasing
• More standard Font Sizes and Styles
• New Font format requires less Resident Memory
• Greater compression for Amiga Fonts and Color Fonts
• Supports International Keymaps
• Accepts ASCB 256 Fonts with International Accents/Special Symbols
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NEW PLAYBACK OPTIONS

• Additional Line and Page Transitions
• Presto Pages for rapid-fire sequence playback
• Playback Modes: Presentation, Random, Sequential, Key Advance, Loop
• Preview Status Bar

OPTIONAL SUPER HIGH RES PROGRAM UPGRADE

• Support for Amiga’s new 1472 x 480 Super High Res Mode (35 ns)
• Super Sharp Display, True 35 nanosecond Pixels Plus Anti-aliasing
• Mixed High Res /  Super High Res modes on a page
• Fully NTSC compatible, use any NTSC Monitor
• Requires 1 megabyte CHIP RAM and new "Super High Res Denise" chip
• Works with Amiga DOS 1.3 and 2.0.

USING BROADCAST TITLER ON YOUR SYSTEM

Broadcast Titler 2 makes extensive use of FAST RAM, or system memory, to give the user as 
much power and flexibility as possible. It is used to run the Broadcast Titler program, to store 
resident fonts and pictures, and to hold the current sequence being edited.

Additional FAST RAM can be added to your Amiga to give you up to eight megabytes of system 
memory. Broadcast Titler 2 requires at least 512 K of true FAST RAM, with 1 megabyte being 
the preferred amount. If you have more FAST RAM installed in your system, you will be able to 
work with more resident fonts and pictures, and can create longer sequences.

The following table approximates the expected program capacity for an Amiga system 
configured with two disk drives and 512 K of CHIP RAM.

MEGABYTES RESIDENT MAXIMUM
FAST RAM FONTS PAGES

1 16 100
2 50 200
2.5 50 400
3 50 600

The above values are approximate, and will vary slightly from machine to machine based on the 
following factors:

- The amount of installed CHIP RAM
- The number of Floppy Disk Drives installed
- Hard Disk buffers and drivers
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- Use of Amiga Dos 1.3 vs. 2.0
- Use of Workbench in Interlaced or Productivity modes
- Execution of other tasks in the background
- The file sizes of additionally loaded fonts

The other type of memory in the Amiga is called CHIP RAM, or graphics memory. It contains 
the high resolution screen image seen on your monitor, plus instructions and data for the graphics 
chips. Broadcast Titler 2 requires only 512 K (half a megabyte) of CHIP RAM, which is the 
minimum amount built in to all models of the Amiga.

A NOTE ON THE AMIGA 3000

Broadcast Titler 2 has been designed to run on all models of the Amiga computer, including the 
new Amiga 3000. The Amiga 3000 is designed to run the new Amiga DOS 2.0. Broadcast 
Titler 2 works with both the A3000 and Amiga DOS 2.0, but for the reasons detailed below, you 
will probably need to add an additional megabyte of RAM on your system for the program to 
run.

The Reason: When you apply power to an Amiga, the Amiga starts up by running special startup 
programs and libraries called "Kickstart". In previous models of the Amiga, this special program 
code was contained in ROM chips on the motherboard, and did not occupy any valuable CHIP or 
FAST RAM.

As of this writing, the final Amiga 3000 "Kickstart" ROMS were not ready, and for now Amiga 
3000’s must load "Kickstart" into FAST RAM at boot time. The loading process occurs during 
the gray "Loading Kickstart" screen, which appears just after turning on the machine.

The problem is that the stock Amiga 3000 ships with only 1 megabyte of FAST RAM, and 
loading Kickstart into RAM steals about 700 K of FAST RAM from the system. As a result, on 
a 2 megabyte machine, you get only 1.28 megabytes of memory after booting. (The total amount 
of memory available after booting is displayed at the top of the Workbench screen.)

Unfortunately, 1.28 megabytes is not enough memory for Broadcast Titler 2 to load its fonts, and 
the program will fail to load properly. So until the Amiga 3000 ROM Kickstart is available, the 
best way around this problem is to add an extra megabyte of memory to the system. This way 
Broadcast Titler is not "crowded-out" of memory, and can fully load all of its fonts and buffers 
into RAM.

The most convenient way to add memory is to install one of the memory expansion boards 
available for the Amiga 2000,2500, or 3000, bringing the total installed memory to 3 megabytes. 
This will give you a total of 2.3 megabytes of RAM after booting your system, which is plenty of 
memory for running Broadcast Titler 2.
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THINGS TO BE AWARE OF

Memory Expansion on the Amiga 500

Although 1.5 megabytes of total RAM are required to run the program, the access speed of the 
available memory is an important consideration. Broadcast Titler requires that at least 512K of 
the available memory is true FAST RAM in order to operate properly. Most memory expansion 
boards for the Amiga 1000,2000,2500 and 3000 are FAST RAM boards.

However, most memory expansion boards for the Amiga 500 which are installed in the A501 
memory expansion slot (located under the machine) fall under the category of SLOW RAM.
The extra memory installed there suffers from "Direct Memory Access Slowdown" during High 
Resolution Overscan display and during Blitter operations. This slot was originally designed to 
hold an additional 512K of CHIP RAM, and therefore the slot is set up with the same DMA bus 
arbitration as CHIP RAM. This can result in dramatically reduced performance if program code 
uses this slower memory.

It is therefore desirable to expand the Amiga 500 with "Internal Memory Boards". Placed inside 
the unit itself, these memory boards offer true FAST RAM performance since they do not use the 
A501 expansion slot, and are therefore not subject to any DMA arbitration.
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I  CHAPTER 2
D IBMOTIP

THE FLOPPY DISK AUTOBOOT MENU

Broadcast Titler’s Autoboot Menu appears when the Amiga is powered while the Broadcast 
Titler Program Disk in drive DFO. The menu is only available if the system has no hard disk. 
The Autoboot Menu provides a function key driven "Shell" to quickly start the program, run the 
Font Converter, or to execute additional utilities.

MAKING BACKUP COPIES

Dual Floppy Disk Drive Users

1. Power on the Amiga system. When asked to insert a Workbench disk, insert the write 
protected Broadcast Tider Program Disk in internal drive DFO:.

2. Insert a blank disk in the other disk drive (either DF1:, DF2: or DF3:).

3. Make a note of which drive contains the blank disk.

4. When the Autoboot Menu appears, press function key F4.

5. Type EXECUTE [SPACE] BACKUP [SPACE] DFO: [SPACE]

6. Type the drive name of the drive containing the blank disk (DFl:, DF2:, or DF3:) followed by 
a colon and then press RETURN.

7. Once you are prompted to press RETURN, do so.

8. Once ALL disk drive lights are off, the backup process is complete. Store the original disk in 
a safe place, and use the backup copy as your program disk.
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Single Floppy Disk Drive Users

1. Power on the Amiga system. Insert the write protected Broadcast Titler Program Disk in 
internal drive DFO: when asked to insert a Workbench disk.

2. When the Autoboot Menu appears, press function key F4.

3. Type EXECUTE [SPACE] BACKUP [SPACE] DFO: [SPACE] DFO: [RETURN]

4. Once you are prompted to press RETURN, do so.

5. Once ALL disk drive lights are off, the backup process is complete. Store the original disk in 
a safe place, and use the backup copy as your program disk.

If you make a backup within Workbench, make sure that the Broadcast Titler disk is named "BT" 
and not "Copy of BT". Do this by clicking the "Copy of BT" icon on the Workbench screen. 
Hold down the right mouse button and highlight the Rename function in the Workbench Project 
menu. Release the mouse button and delete the "copy of " part of the name so that only "BT" 
remains. Press RETURN once you have finished.

HARD DISK INSTALLATION

Broadcast Titler may be installed onto a hard disk using our Hard Disk Install program. All 
Broadcast Titler fonts, pictures, and data may be saved or retrieved from a hard disk. To install 
all necessary files from the Broadcast Titler Program Disk to your hard disk, follow these 
installation instructions.

Before you attempt to install Broadcast Titler on your Hard Disk, make a backup copy of your 
Broadcast Titler Program Disk. Then follow the installation procedure below using your backup 
disk.

1. Decide which hard disk drive device onto which you want Broadcast Titler to be installed. For 
example: DHO, DH1, FH1, HDO, WORK, etc. We recommend A2500/A200HD users to use 
drive device "Work".

2. Boot your hard disk so that you get a Workbench screen with disk icons.

3. Insert the BACKUP copy of the Broadcast Titler Program Disk in drive DFO:

4. Double click the Broadcast Titler disk icon named BT.

5. Double click the icon named HDInstall.

6. Once the icon window appears, type EXECUTE [SPACE] BTINSTALL [SPACE].
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7. At this point, type in the hard disk drive device name you wish to use (followed by a colon) 
and press RETURN. Example:

Execute [SPACE] BTInstall [SPACE] Work: [RETURN]

8. The BTINSTALL Program will now begin to create a drawer named "BTitler2", with an 
associated icon, and copy all the necessary programs, files and icons onto the hard disk partition 
you selected. If you already have Broadcast Titler 1.0 installed on your hard disk, it is in drawer 
"BTitler", and it will not be affected by installing Broadcast Titler 2.

9. You may need to rearrange the drawer icon location so that it can be easily seen from your 
hard disk window in Workbench.

PLEASE NOTE (A2500/A2000HD owners EXCLUDED): If you start Broadcast Titler from the 
Workbench screen be sure to run FastMemFirst before you run Broadcast Titler. Most Amiga 
hard disk systems are currently configured such that the Amiga DOS command "FastMemFirst" 
is automatically executed at boot time via a line in the "Startup-Sequence" file.

If this command is not in the System drawer of your hard disk, then you can copy it from either 
the Broadcast Titler Program Disk’s System drawer or the Workbench 1.2/1.3/2.0 disk’s System 
drawer. You can run FastMemFirst from the Startup-Sequence file of the hard disk so that it is 
activated each time you boot your system.

Simply add a single line at the end of the file that contains the command "FastMemFirst". In 
older versions of Amiga DOS, this command was named "SlowMemLast", but it performs the 
same function as the newer FastMemFirst command.

Refer to Appendix A : Using ED The System Text Editor, for further instructions on editing the 
Startup-Sequence file.

MAKING WORKING DISKS

Before you use Broadcast Titler for the first time, you will need to FORMAT or INITIALIZE 
two diskettes. Please refer to your Amiga owner’s manual for instructions on formatting blank 
disks. Label the first blank disk BTFonts and the other, BTSequences. As a convenience, floppy 
disk users can format a blank data disk in the Autoboot Menu by pressing function key F5.

A  When formatting data disks, do not type "FONTS" to declare the name of the disk as it may 
confuse the system. Instead, use a name such as "BTFonts".
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LOADING BROADCAST TITLER

Floppy Disk Drive Users

1. Power on the Amiga System. When prompted to insert a Workbench disk, insert your 
BACKUP copy of the Broadcast Titler Program Disk in drive DFO. Broadcast Titler’s Autoboot 
Menu will appear.

2. Press function key FI to start the program. In a few moments, the "Main Menu" screen will 
appear. Welcome to Broadcast Titler!

Hard Disk Users

1. Boot your hard disk as usual.

2. When the Workbench screen appears, Double-click on the hard disk icon for the drive on 
which Broadcast Titler was previously installed.

3. Double-click on the drawer icon labeled "BTitler2".

4. Double-click on the BT! program icon. In a few moments, the "Main Menu" screen will 
appear. Welcome to Broadcast Titler!

NOW ON TO THE TUTORIALS!

Now that you have started Broadcast Titler it is probably best to follow through the step-by-step 
tutorials included in Chapter 3 to get on the fast-track to mastering the program and its new 
features. After that you will probably want to skim through Chapters 4 through 10 which serve 
as a detailed reference for each of the program’s menus.
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□

CHAPTER 3

The following set of mini-tutorials will help to demonstrate how to navigate through menus, 
create and play effects, load and place IFF pictures, Roll credits, Crawl messages, and save the 
resulting sequence onto a disk.

In order to save the sequence, this tutorial requires the use of a ready formatted floppy disk for 
storing the sequence data riles.

To begin, start Broadcast Titler by clicking on the BT! icon or by pressing FI from Broadcast 
Titler’s Autoboot Menu as described in Chapter 2.

□ BASIC OPERATION - NAVIGATING THROUGH MENUS □

Broadcast Titler’s menus have been designed to use both the mouse and the keyboard. For most 
users, the using mouse is probably the fastest and the most preferred method for operating 
Broadcast Titler. The specifics of mouse and keyboard menu operation are covered in this 
section.

This section also defines the standard working terminology used throughout this manual. To get 
the most out of this section you should first start up Broadcast Titler following the instructions 
given in Chapter 2.

JUMPING BETWEEN TEXT EDIT MODE AND THE MAIN MENU

After the program has loaded, slowly click the Right Mouse Button a few times. With each click 
of the Right Mouse Button, the menu bar at the bottom of the page will either appear - revealing 
the Main Menu, or disappear - showing the blue Text Edit Mode screen.

Keyboard-only users should press the ESC key instead of clicking the Right Mouse Button.

ENTERING THE TEXT EDIT MODE

Click the Right Mouse Button so that the menu bar at the bottom of the screen disappears. This 
screen without the menu bar is the Text Edit Mode in which all text editing occurs.

Type in a line of text from the keyboard. As each character is typed, notice that the yellow 
vertical Text Edit Cursor advances to the next character position in the line. This cursor marks 
the insertion point at which text is inserted or deleted from the current line.
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To move the cursor within the line, press the Left or Right Arrow keys from the keyboard. To 
move the cursor vertically, press the Up or Down Arrow keys. The BACKSPACE and DEL 
keys are used to delete existing characters. These as well as numerous other useful editing 
commands are fully explained in Chapter 4 : The Edit Mode.

ENTERING THE MAIN MENU

From the Text Edit Mode, click the Right Mouse Button or press ESC from the keyboard. The 
Main Menu will appear. Move the mouse slightly and you will see a rounded yellow dot moving 
on the screen. This is the MOUSE POINTER, and it is used to make selections in the menu bar.

HIGHLIGHTING A BUTTON

Move the Mouse Pointer on top of the PAGE button on the Main Menu. When you do this 
notice that the PAGE button changes from blue to red. This is referred to as HIGHLIGHTING a 
menu button.

Highlighting can also be accomplished via the keyboard. Press the Right Arrow key on the 
keyboard five times. Each time the Arrow key is pressed, the menu highlight advances to the 
next button on the menu. To move the highlight in the opposite direction, press the Left Arrow 
key.

SELECTING A BUTTON

Using the mouse, highlight the FONT button in the Main Menu and click the Left Mouse Button 
once. The Font Menu appears. This process of highlighting a menu item and then clicking the 
Left Mouse Button is called SELECTING.

Or to select the menu item via the keyboard, press Left or Right Arrow key to highlight the 
FONT button. Then press the Right ALT key from the keyboard. Pressing the Right ALT key 
serves the same function as clicking the Left Mouse Button.

CHANGING NUMBER VALUES

In the Font Menu, highlight the SHADOW SIZE button. Move the mouse so the Mouse Pointer 
is placed just to the right of the "2" inside the button. To increase the number, click on the right 
side of the number ”2". The value will change to "4". With each click on the right side of the 
number, the value will increase and the new Shadow Size will be displayed in the button. To 
decrease the number, click just to the left of the displayed number.

Alternatively, number values can be changed from the keyboard by highlighting the button and 
then pressing the Up Arrow or Down Arrow keys to increase or decrease the value.
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DIRECT KEYBOARD NUMBER ENTRY

Numbers may also be entered directly from the keyboard by highlighting a number button, 
typing in a numeric value, and then pressing RETURN. If you make a mistake while typing, 
press the BACKSPACE or DEL keys and retype the number. Numbers that are out of range for 
a given operation will be automatically capped to the maximum allowable value.

BROWSING THROUGH LIST-STYLE BUTTONS

Highlight the RESIDENT FONTS button in the Font Menu. This is a list-type button that selects 
an entry from a list of names. Click on the right half of this button. The next font name in the list 
will appear inside the button. Each click will advance to another font name, and will cycle 
through to the start of list when the last font is reached. To go back to the previous font in the 
list, click on the left half of the button.

Similar list-style buttons in this menu are the FACE and FACE PATTERN buttons. Such 
buttons are also encountered in the Line Pattern Menu, the Picture Menu and the Effects Menu.

From the keyboard, highlight the button, and then press the Up Arrow or Down Arrow keys to 
step through the listed items.

RETURNING TO THE PREVIOUS MENU

To exit the current menu and return to the previous one, click the Right Mouse Button or press 
ESC from the keyboard. As a shortcut, one may return directly to the Text Edit Mode from 
inside any menu by pressing the Right Amiga key from the keyboard.

LEARNING THE REST OF THE MENU FUNCTIONS

Now that you have learned the basic operation of the menus, you should be able to navigate 
comfortably through Broadcast Titler’s and investigate the more advanced features of the 
program.

For a hands-on guided tour of Broadcast Tider, follow the tutorials in the remainder of this 
chapter. To learn more about editing in Broadcast Titler’s Text Edit Mode, refer to Chapter 4 : 
THE EDIT MODE. Chapters 5 through 10 discuss each of the primary menus in detail, and give 
step-by-step instructions for several of the most commonly used functions.
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G CREATING PAGE TRANSITIONS
This tutorial will create two pages of text, demonstrating how to assign page effects and play 
back a sequence.

1. For simplicity, start with a new sequence. If you already have a sequence in memory, select 
CLEAR SEQ from the FILE MENU to delete it. Press "Y" to confirm the action. Press "N" in 
response to the "Reload Fonts?" prompt.

2. Press the Right Amiga Key to enter the Text Edit Mode. At the top of the page type the word 
"TELETYPE!", but don’t press RETURN at the end of the line.

3. With the Text Edit Cursor still at the top of the page, simultaneously press CTRL and "K".

4. Press RETURN. Next, simultaneously press CTRL and "P". The word "TELETYPE!" will 
be pasted onto line two.

5. Repeat step 4 above until you reach the bottom of the page.

6. Click the Right Mouse Button to display the Main Menu. Select PAGE. The Page Menu 
appears.

7. Select the Effect Name Button for page one which says "Cut". The Page Effect Menu appears.

8. Click on the "Teletype" button at the upper left of the menu. Click the Right Mouse Button to 
exit the menu. The Page Menu reappears.

9. Select the APPEND button at the bottom of the menu. A new blank page is added to the end 
of the sequence, and is highlighted in the Page List.

10. Click on the highlighted Effect Name Button for page two (it currently says "Teletype").
The Page Effect Menu appears.

11. Select the "Weave" effect button, which is one column over from "Teletype". Click the 
Right Mouse Button three times to return to the Text Edit Mode, or you can press the Right 
Amiga Key as a keyboard shortcut.

12. Type the word "WEAVE!", but do not press RETURN at the end of the line.

13. With the Text Edit Cursor still at the top of the page, simultaneously press CTRL and "K".

14. Press RETURN. Next, simultaneously press CTRL and "P". The word "WEAVE!" will be 
pasted onto line two.
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15. Repeat step 14 above until you reach the bottom of the page.

16. Click the Right Mouse Button to display the Main Menu. Select PAGE. Select LAYOUT. 
The Layout Menu appears. Under PAGE CENTERING, select "Right". Click the Right Mouse 
Button twice, to return to the Main Menu.

17. Select the "H" (Home) button on the menu. Page one "TELETYPE!", appears. Press 
function key FI from the keyboard to play the sequence.

THE ROLL EFFECT

The Roll effect will scroll consecutive pages of text and graphics vertically up the screen. The 
Roll is most often used at the end of a program during the finishing credits. Broadcast Titler 2 
offers a smooth, gap-free, evenly spaced, full overscan Credit Roll under normal speeds.

The Roll effect is one of the most complex within Broadcast Titler, yet it is also simple to use. 
You have full control over the speed, time, page cropping, and length of the Roll. The Roll effect 
can have the following attributes:

- Each page can have its own Roll Speed.
- A different 16 color palette can be displayed on each page
- The Roll will automatically end by holding the last page on screen. To end the Roll with 
the last page scrolling off the screen, add a blank page after the last page of text.
- Page backgrounds and 16 color IFF pictures can be included in the Roll.
- The Roll effect can be interspersed with other effects in the sequence, i.e. it is not 
necessary to Roll the entire sequence.

PRE-TIMED ROLLS

As with other effects, there are nine speeds to choose from. However, for the Roll, Speed 1 is 
different from all the other speeds. When you choose Speed 1, you can set the amount of time 
that you wish the Roll to last, in order to fill a specific time segment with credits.

The first page in the Roll having Speed 1 determines the total Roll segment duration via the 
value in the HOLD time button for that page. During the Roll, the actual scroll rate is averaged 
for all consecutive pages which have Roll Speed 1, so that the Roll sequence completes in the 
designated time.

Example:

For instance, suppose you wanted five pages of text to be scrolled in 20 seconds. First, type in 
the five pages of text. Then on Page One you should select the Roll effect and set the effect 
SPEED to "1". Then highlight HOLD, type in a time of "20.00", and press RETURN. DO THIS 
ONLY FOR PAGE ONE.
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In the Page Menu, click on REP EFFECT four times to set the Roll effect and Speed 1 for the 
remaining pages.

A There are potentially over 1,000 speeds available with the Speed 1 Pre-timed Roll option. 
However, some speeds will look much better than others, in part due to side effects of video 
interlacing and vertical motion at some speeds.

It is best to set the Roll Speed so that each page Rolls on and off the screen in 3 to 5 seconds, 
with the ideal speed being about 4 seconds per page. If the result is not what you desire, you can 
still use one of the pre-defined speeds (2 through 9) which have been selected for optimum 
smoothness.

A If you are Rolling complex pages, or are Rolling at very high speeds (Speed 7 or higher), you 
may want to use the Presto Page option to prevent gaps from appearing between successive 
pages.

ROLL CROP MARGINS

Because you can use fonts in many different heights, there may be a possibility of Roll gaps 
appearing between successive pages. To alleviate this problem, you can change the ROLL 
CROP settings. The ROLL CROP allows you to adjust the top and bottom areas of each page 
that will be seen during the Roll.

Enter the PAGE MENU and select LAYOUT. Highlight the BOT button under ROLL CROP to 
change the bottom Roll cropping. The text window in the top half of the page will shift up to 
show the ROLL CROP indicator. The BOT value can be changed by typing in a number and 
pressing RETURN, or by depressing the Left Mouse Button on the left or right side of the 
displayed number. The Roll will scroll the entire area between the TOP and BOTTOM Roll 
Crop Margins.

Refer to ROLL TUTORIAL 2 below for a complete example.

ROLLING PRESTO PAGES

With slower processors, the Amiga may not always manipulate graphics fast enough to display all the 
Roll pages continuously. This is most evident when using smaller sized fonts. The Presto Page 
option can help remove any gaps that may appear between these pages. Presto Pages are set in the 
PAGE MENU and must be pie-rendered in the PLAY MENU before playing the Roll sequence.

To declare a Presto Page, highlight a page in the PAGE MENU and select the PRESTO button 
on the lower right side of the menu. The letter "P" will appear on the right side of the selected 
page. When drawing Presto Pages, each page is converted to a compressed format that 
Broadcast Titler will display as fast as possible during playback.
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▲ The Presto Page feature is intended for speeding up text rendering and will not support full 
page IFF Pictures or large patterns due to the complexity of its compression routines. Using 
some pictures or patterns may require some experimentation.

ROLL TUTORIAL 1: Rolling Even-Length Pages

This tutorial will Roll three pages of text. It also demonstrates the advantages of using a 50 
scanline font size to create even-length Roll pages which fit exactly within the program’s default 
Roll Crop Margins.

1. Select CLEAR SEQ from the FILE MENU. Type "Y" to confirm. Then type "N" at the 
"RELOAD FONTS?" prompt.

2. Select the SWISS 50 font from the FONT MENU. Then go to the Text Edit mode by clicking 
the Right Mouse Button.

3. Press CTRL and "C" simultaneously. This will center all new text that will be typed.

4. On Line One, type "1" and press RETURN. On Line Two, type "2" and so on until you reach 
Line 8 at the bottom of the page. (PAL users will type until you reach Line 10.)

Press the SHIFT and PgDn keys simultaneously to create another page.

Continue to type "9" on the first line, "10" on the next until you reach "16" at the bottom. (PAL 
users will type from "11" through "20".)

Press the SHIFT and PgDn keys again to create the third page.

Continue to type "17" on the first line, "18" on the next until you reach "24" at the bottom. (PAL 
users will type from "21" through "30".)

5. Now enter the PAGE MENU and click on the Effect Name button for Page One. The Effect 
Name buttons are located to the right of the page listings.

Doing this will automatically bring up the EFFECT MENU for Page One.

6. Select the Roll Effect Button located on the upper left side of the menu.

Press ESC or click the Right Mouse Button to return to the PAGE MENU.

Now you’ve set the effect for the first page, but not for the rest of the pages. Locate the REP 
EFFECT button under the Effect Name boxes.
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Click on this button twice to replicate the Roll effect onto the second and third pages.

7. Now exit to the MAIN MENU by clicking the Right Mouse Button. Click on the "H" (Home) 
button in the Main Menu to jump to Page One in the sequence, or press HOME from the 
keyboard. Press FI to play the sequence.

As you watch the text Roll up the page, you will notice that there are no gaps between the pages, 
due in part to the even line spacing of the size 50 Swiss Font, which happens to entirely fill the 
whole page with text, leaving no extra space at the bottom.

The Roll will end shortly, holding the third page on the screen.

8. To keep the last page on screen for a longer time, you need to change the HOLD time for the 
very last page of the Roll as follows.

From the MAIN MENU, select PAGE. Click on the Effect Name button for Page Three. 
Highlight the HOLD button with the Mouse Pointer. Type in a Hold value of "10.00" seconds, 
and press RETURN.

Click the Right Mouse Button twice to return to the Main Menu. Click on the "H" (Home) 
button. Press FI to play the sequence again. The last page of the Roll (page 3), will now hold on 
screen for a total of 10 seconds.

ROLL TUTORIAL 2 : Rolling Odd-Length Pages

This tutorial will Roll two pages of text. It also demonstrates the use of the Roll Crop Margins to 
eliminate the extra blank space at the bottom of some pages. Extra blank space can occur when 
text on a page cannot reach the very bottom of the screen because of the font size used.

1. Select CLEAR SEQ from the FILE MENU. Type "Y" to confirm. Then type "N" at the 
"RELOAD FONTS?" prompt.

2. Select the SWISS 37 font from the FONT MENU. Then go to the Text Edit mode by clicking 
the Right Mouse Button.

3. Press CTRL and "C" simultaneously. This will center all new text that will be typed.

4. On Line One, type "1" and press RETURN. On Line Two, type "2" and so on until you reach 
Line 10 at the bottom of the page. (PAL users will type until you reach Line 10.)

Press the SHIFT and PgDn keys simultaneously to create another page. Continue to type "11" on 
the first line, "12" on the next until you reach "20" at the bottom. (PAL users will type from "11" 
through "20".)
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5. Now enter the PAGE MENU and click on the Effect Name button for Page One. The Effect 
Name buttons are located to the right of the page listings. Doing this will automatically bring up 
the EFFECT MENU for Page One.

6. Select the Roll Effect Button located on the upper left side of the menu. Press ESC or click 
the Right Mouse Button to return to the PAGE MENU.

Now you’ve set the effect for the first page, but not for the rest of the pages. Locate the REP 
EFFECT button under the Effect Name boxes. Click on this button once to replicate the Roll 
effect onto the second page.

7. Now exit to the MAIN MENU by clicking the Right Mouse Button. Click on the "H" (Home) 
button in the Main Menu to jump to Page One in the sequence, or press HOME from the 
keyboard. Press FI to play the sequence.

As you watch the text Roll up the page, you will notice that there are gaps between the pages 
because the text lines typed in the SWISS 37 font does not quite reach the bottom of the page, 
thereby leaving an empty space between pages during the Roll.

8. To remove the gap between the pages, select PAGE from the Main Menu. Select LAYOUT, 
and the Page Layout Menu appears for Page One.

9. NTSC Version:

Highlight the ROLL CROP BOT button. Type in a value of "416" and press RETURN. Qick the 
Right Mouse Button twice to return to the Main Menu.

Press FI to play the sequence again. This time the text on lines "10" and "11" will show no gap 
since the Roll Crop Bottom margin has been fine-tuned to fit the layout of the text on the page by 
eliminating the blank area at the bottom of Page One.

PAL Version:

Highlight the ROLL CROP BOT button. Type in a value of "518" and press RETURN. Click the 
Right Mouse Button twice to return to the Main Menu.

Press FI to play the sequence again. This time the text on lines "13" and "14" will show no gap 
since the Roll Crop Bottom margin has been fine-tuned to fit the layout of the text on the page by 
eliminating the blank area at the bottom of Page One.
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CRAWLING MESSAGES

The Crawl Effect will slide a page of text one line at a time from right to left across the screen. 
Text can be Crawled at almost any scanline position on the screen. Each line of text will be 
crawled continuously, one after the other.

It is recommended that all lines in the Crawl have the same height in order for the Crawl to ran 
properly. However, it is possible to use different font sizes and styles as long as the line heights 
are made the same. Do this by selecting the largest font size, pressing RETURN several times to 
create blank lines of that font’s height, and then typing in the text with any styles and sizes desired.

The Crawl effect will also work with small IFF brashes, such as symbols or logos, placed within 
the Crawl Text lines.

To have all of the text Crawl smoothly without gaps, the entire Crawl Message must be 
contained in one page of text. The amount of information that you can Crawl continuously 
depends on the size of the font being used. Multiple Crawl pages can be placed back to back, but 
a short gap will appear after the end of each page.

For instance, if you use a size 37 font, about 10 lines of text (13 PAL) can be Crawled without a 
gap. If you use a size 50 font, about 8 lines of text (10 PAL) can be Crawled. Additional text 
lines can be squeezed onto a page by expanding the TOP, BOTTOM, LEFT, and RIGHT Page 
Margins in the LAYOUT MENU.

There are several guidelines to keep in mind when using the Crawl effect:

TYPING TEXT FOR THE CRAWL

▲ The Crawl works most best when the font sizes used are the same height (MAX. HEIGHT 120).

A When typing the last word on a line, the word should NOT be split by typing half of the word 
and pressing RETURN, then typing the rest of the word on the next line. If a word will not fit on 
the line, the whole word should be placed on the following line.

A All of the text must be left justified.

WORD SPACING CONTROL FOR CRAWL LINES

If during playback, the last word on a crawl line runs too close to the first word of the following 
line, you may need to add a little space between the two words to maintain even spacing.

Each text line on the page starts at the Left Margin. By adding a small space between the Left 
Text Margin and the first word of the Text line, you are also effectively adding a small gap 
between the end of the last line and the beginning of the next line of text.
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To do this simply type a SPACE as the FIRST character of each text line. This moves the text 
line slightly to the right, and slightly farther away from the Left Margin.

If necessary, the amount of space added at the beginning of each line can be fine-tuned by typing 
CTRL S (character Separate) or CTRL-T (character Tuck) at the beginning of the line until the 
line is placed just right.

SETTING THE CRAWL LINE POSITION

▲ The Crawl line can be placed on any vertical position on the screen by setting the CRAWL 
LINE position in the PAGE LAYOUT MENU for the page PRECEDING the Crawl page. This 
is intentionally set up in this manner so that the Crawl Line position can be visually aligned with 
text from the preceding page.

Therefore, you should go to the previous page before setting the CRAWL LINE in the LAYOUT 
MENU. In this way, the Crawl position can be accurately aligned with lines of text from the 
previous page which will remain on screen during the Crawl Effect.

Example:

(Page 1) Background Text
CUT Effect
Set the Crawl Line Top for following Crawl Page.

(Page 2) Crawl Text
CRAWL Effect
Crawl Line window position taken from page 1 setting.

▲ When Crawling over an existing page of text, it is usually best to match the top of the 
CRAWL LINE to the same position of an existing line from the previous page. This will prevent 
the possibility of background letters from the previous page being cut-off when the Crawl begins.

A The Crawl effect window uses the 16 color palette of the top line from the Crawl text page. If 
the previous page contains a different 16 color palette, it will still keep those colors intact while 
the Crawl is active.

A Only one page of text can be crawled at time. If there are additional pages to be crawled, a 
short gap will appear until the previous page has finished crawling.
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TUTORIAL-CRAWLING A PAGE OF TEXT

1. For simplicity, start with a new sequence. If you already have a sequence in memory, select 
CLEAR SEQ from the FILE MENU to delete it. Press "Y" to confirm the action. Press "N" in 
response to the "Reload Fonts?" prompt.

2. From the MAIN MENU, select FONT. Select the Swiss 50 font. Click the Right Mouse 
Button to exit the menu.

3. Type one full page of text. If a word will not fit at the end of a line, delete the word, press 
RETURN and continue on the next line. Do not split words between lines.

4. Click the Right Mouse Button to enter the MAIN MENU. Select PAGE, then select EFFECT.

5. Select the CRAWL effect button in the effect list. Then click on the far right side of the 
SPEED button to change the speed to "4".

6. Double click the Right Mouse Button or press ESC twice to go to the MAIN MENU.

7. Press FI to play the effect. The Crawl will begin from the right side of the screen and at the 
top of the page. Once all the lines have been Crawled, the MAIN MENU will appear.

A The HELP key on the keyboard can be used to pause the Crawl at any point while it is active. 
If you want to exit the effect while it is running, pressing the ESC key will automatically stop 
any running sequence.

CRAWLING AT THE BOTTOM OF THE SCREEN

1. To Crawl from the bottom line of the page, the CRAWL LINE must be adjusted. From the 
MAIN MENU, select PAGE, then LAYOUT.

2. Highlight the CRAWL LINE button. The CRAWL LINE "TOP" button refers to the scanline 
at which the topmost edge of the Crawl window will appear. The Crawl window can be placed 
on any even-numbered scanline on the page.

3. NTSC Version:

Move the CRAWL LINE down the page to scanline 408 by highlighting the CRAWL LINE 
button. Then type in "408" and press RETURN. This will start the Crawl at the bottom of the 
screen.

23



PAL Version:

Move the CRAWL LINE down the page to scanline 494 by highlighting the CRAWL LINE 
button. Then type in "494" and press RETURN. This will start the Crawl at the bottom of the 
screen.

4. Click the Right Mouse Button twice, or Press ESC twice to return to the MAIN MENU. Press 
FI to start the Crawl.

CRAWLING TEXT OVER AN EXISTING PAGE

1. This example uses the page that was just created in the previous example to Crawl over the 
bottom line of another page.

2. Go to the PAGE MENU and select INSERT. This will insert a blank page (with a CUT 
effect) before the Crawl page. Once you’ve done this, select EDIT, which brings you back to the 
TEXT EDIT MODE.

3. Type in another page of text with the Swiss 50 font. Press FI when you are done. You will 
notice that Page One Cuts onto the screen and then holds. Then Page Two Crawls over the 
bottom line of the previous page, leaving the existing text intact.

D CREATING LINE TRANSITIONS

This is a complete example showing how to create a page containing line transitions.

1. Enter the Main Menu by clicking the Right Mouse Button.

2. Press the SHIFT and PgDn keys simultaneously (Numeric Keypad 3) to create a new page.

3. Select FONT from the Main Menu.

4. Select the font "Swiss 50" if it is not already the current font. Click the Right Mouse Button to 
return to the Text Edit Mode.

5. Press RETURN four (4) times.

6. Type in the following lines, pressing RETURN after each line.

USA [RETURN] 
NIGHTLY [RETURN] 
NEWS [RETURN]

24



7. Click the Right Mouse Button. Select FONT from the Main Menu.

8. Select the font "Swiss 37". Click the Right Mouse Button.

9. Type in the word "with" followed by your name. For example:

"with Julie Anderson"

10. Press the UP Arrow key once so the Text Edit Cursor is on the line containing the word "NEWS".

11. Simultaneously press SHIFT and the Hyphen key to type an Underline character. The 
Underline Menu appears.

12. Press the Up Arrow key ONCE to move the red Underline Cursor up by two scanlines. Next, 
press and hold the Underline key (SHIFT Hyphen), until the red underline extends slightly 
beyond the rightmost character on the page. Press ESC to exit the Underline Menu.

13. Click the Right Mouse Button to enter the Main Menu. Select LINE. Then select EFFECT 
from the Line Menu. The Line Effect Menu appears.

14. Click the Ln Up button on the menu a few times until the text line indicator reads "USA".

15. Select the "7 Slide Up" line effect box near the top of the menu.

16. Click on the Ln Down button. The text line should display "NIGHTLY". Select the "7 Slide 
Up" line effect box near the top of the menu.

17. Click the Ln Down button again and the text line should now display "NEWS". Select the "7 
Slide Up" line effect box.

18. Click on the Ln Down button once more. The text line should now display "with Julie 
Anderson". Select the "5 Ease Right" line effect box.

19. Click the Right Mouse Button three times to return to the Text Edit Mode. Press FI from the 
keyboard to view the effect for this page.

This was an example of "Simultaneous" line transitions. The specifics of both Line-by-Line and 
Simultaneous effects playback are covered in the Line Effect section of the Line Menu chapter.
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□ CREATING BRUSHES IN DELUXE PAINT___________
THIS TUTORIAL EXPLAINS HOW TO CREATE IFF BRUSHES FOR PATTERNED TEXT 
FILLS IN BROADCAST TTTLER USING Deluxe Paint.

Necessities for this tutorial: Deluxe Paint and a formatted data disk.

• Brushes should be created in high resolution (640 x 400 pixel resolution). If the brush pattern 
is less than half of the full screen width, Broadcast Titler will automatically repeat the pattern for 
every character across the page.

• Brushes must be at least the full height of the chosen font in order to fill the text properly. If 
the brush is not the full height of the font, the bottom of the characters may be black. The brush 
pattern must be limited to eight colors.

To begin, insert your Deluxe Paint program disk and click on the DPaint icon to start up the 
program.

1. When the Choose Screen Format requester appears, select Hi-Res 640 x 400, LOAD ALL, 
and Number of Colors = 8. Leave all other settings at their default values.

2. Press the Right Mouse Button at the top of the screen to access the PREFS Menu. From the 
PREFS menu, select COORDS to display the cursor coordinates. Next, click on the GRID tool, 
or press "g" on the keyboard.

3. Now we will make two brashes with gradient spreads. One will be a horizontal spread, the 
other a vertical spread.

MAKING A VERTICAL SPREAD BRUSH

1. Press "p" from the keyboard to bring up the Palette Menu. The following steps will show 
how to create a range of colors. The eight colors in the palette are numbered from Color 0 to 
Color 7, starting from the upper left to the lower right.

2. To create a spread of colors from a color in Position 1 to a color in Position 7, click on the 
Color 1 box in the Palette Menu (the Cream color). Then click on the SPREAD button. Now 
select the Color 7 box. A spread of colors will be created from Colors 1 to 7.

3. We will now create a range for the new spread of colors. The range must be adjusted before 
the gradient spread is created.

Locate the RANGE Numbers 1 - '6 to the right of the RANGE Button. Leaving the selected color 
on Color 7 (Light Blue), click on the Number 2 box by the RANGE Button. Now click on the 
RANGE Button, then the Color 1 box in the palette. Select OK.

26



4. Now choose the FILL TYPE requester by pressing SHIFT "F" from the keyboard. To create a 
vertical gradient spread, press the TOP-TO-BOTTOM ARROW button to the right of the word 
"Gradient:". Select OK. A small rectangle will appear on the TITLE BAR showing the gradient 
colors.

5. Press SHIFT "R" to select the FILLED RECTANGLE tool. The pointer will turn into a 
crosshair cursor.

6. Now create a 105 x 105 pixel rectangle. Go to the center of the screen. Press and hold down 
the Left Mouse Button while dragging the Mouse down and to the right. Notice the coordinates 
on the top right of the title bar change as the mouse moves. Move the Mouse until the 
coordinates are at 105 x 105, then release the Mouse Button. The rectangle will be filled with a 
gradient spread from top to bottom.

7. To grab the brush, click on the BRUSH SELECTOR tool or press "b" from the keyboard. 
Place the crosshairs on the top right of the spread. Qick and hold down the Left Mouse Button, 
moving to the right and down until the coordinates are at 105 x 105. When you release the 
Mouse Button, the pointer will be carrying the brash.

8. Go to the Brash Menu and select SAVE. Put the formatted data disk into DF0: after the 
requester appears. Qick on the DF0: gadget after the disk drive light turns off.

When saving brashes for text fills, it is convenient to save the brash with a name followed by the 
height of the font which it will be used for. For example: VSpread.105.

9. Click on the box next to the word "File". Type in "VSpread.105", then click on SAVE to save 
the brash to the floppy disk.

MAKING A HORIZONTAL SPREAD BRUSH

1. Select CLR or press SHIFT "K" from the keyboard. Press SHIFT "F" to bring up the FILL 
TYPE requester again.

2. Select the (middle) LEFT-TO-RIGHT Arrow button to the right of the word "Gradient:" to 
select the horizontal direction gradient fill. Select OK.

3. Press F10 to remove the Title Bar and Toolbox from the screen, then press F9 to show the 
Title Bar. This will make room to create the horizontal spread on the screen.

4. Select the FILLED RECTANGLE tool, or press SHIFT "R", and make a rectangle from the 
far left of the screen to the extreme right, until the displayed size is 641 x 105 pixels. Check the 
coordinates to get the exact size.
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5. Press ”b" to select the BRUSH SELECTOR tool. Grab the whole rectangle as a brush the 
same way that the vertical brush was selected in the previous example.

6. Save the brush from the Brush Menu using the file name "HSpread 105". Refer to #8 in 
MAKING A VERTICAL SPREAD BRUSH in the previous tutorial.

7. After saving the brush, select QUIT from the Picture Menu to get back to the Workbench.

□ FILLING TEXT WITH IFF BRUSH PATTERNS ________

User created IFF brushes can be applied to text to add variety to the single color characters that 
are used in Broadcast Titler. In order to use this feature, one must start with an IFF brush pattern 
or a digitized image, using up to eight colors. This tutorial will show how to load in previously 
created IFF brushes and type with text filled with patterns from these brushes. This tutorial will 
also demonstrate how to change the color palette of the text to achieve different coloring effects 
with patterned text.

This tutorial has been created to be used with a single-disk-drive system.

CREATING A REPEATING PATTERN TEXT FILL

1. Boot Broadcast Titler. Once the program has loaded, remove the Broadcast Titler Program 
Disk from DFO:, and replace it with your Data Disk containing the IFF brushes created in the 
previous tutorial.

2. In the MAIN MENU, select FILE, then LOAD PICTURE.

3. Select the "VSPREAD.105" entry in the list of files that are displayed in the DOS MENU for 
DFO:. If this name does not appear in directory window, click on the Down Arrow button to the 
directory window, or press the Down Arrow key on the keyboard to list additional files. Once 
the picture is loaded it will be stored in resident memory for use as either a picture or as a text fill 
pattern.

4. To fill text with the brush pattern, go to the FONT MENU.

5. In the FONT MENU, select a font you wish to use with the brush pattern. A larger font size 
should be used since the brush size is 105 scanlines high. Ideally the height of the brush should 
closely approximate the height of the characters that will be used for the filled text.

6. When the font has been chosen, locate the FACE PATTERN button on the last row of 
buttons. The standard setting is "SOLID". Clicking on this button will list consecutive names of 
IFF pictures or brushes that have been loaded during this session.
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Click on the word "SOLID" to show the "VSPREAD 105" brush. The letter "A" displayed on 
the menu will be M ed with the brush pattern to preview the fill effect for that font.

If the font is short, and only uses the top portion of the brush pattern, you can select a larger font. 
Text typed with the larger font will use more of the brush pattern’s surface area.

7. Press the Right Mouse Button or ESC from the keyboard to enter the Text Edit mode. Type 
out a full line of text. As you type each character, the brush pattern will be used repeatedly for 
each character that is typed on the line. This is because the brush that has been used for this 
example is only a fraction of the width of the screen, in which case the pattern is reused for each 
character on the line.

▲ When using this feature, Broadcast Titler’s anti-aliasing feature is automatically disabled.

CREATING A WIDE PATTERN TEXT FILL

The second part of this tutorial will demonstrate the use of a wider brush pattern that will reveal 
itself from left to right as text is typed across the page. This option is ideal for color spread fills 
that progress from left to right with horizontal color gradients or blends.

Each character typed across the page reveals the portion of the brash that lies underneath the 
character, allowing one to "See through" to the underlying brash.

1. In the Text Edit mode create a new line by pressing RETURN. In the Main Menu select FILE 
and then select LOAD PICTURE. When the file requester appears select the "HSPREAD.105" 
brash created from the previous tutorial.

2. Go to the FONT MENU. Click on the FACE PATTERN button until the "HSPREAD.105" 
brash name appears in the button. When multiple IFF pictures or brashes have been loaded, the 
names will appear the order in which they were loaded from the File Menu.

3. Press ESC or the Right Mouse Button to enter the Text Edit mode. Type a full line of text 
across the page. The text will be filled with the wide brash pattern as if it was stamped from the 
"HSPREAD.105" brash.

GUIDELINES FOR USING PATTERN FILLED TEXT

There are numerous applications for using textured brashes for pattern filled text. Feel free to 
experiment with brashes of your own. It is important that the brashes used for this feature are 
made using only the first eight colors in the color palette.

It is equally important that the height of the brash be as tall as the largest letter in the font that 
you will be using. This is to insure that the pattern is capable of filling the entire height of the 
text you will be using.
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A To conserve memory, it is important to limit the height of the brushes to about 150 scanlines 
high, or smaller.

If the brush is too short or too narrow, the filled text may show a blank border area on the right 
and lower edges of the character face. If in doubt, make your brushes just a little taller than the 
height of the font and at least the width of the letter "W". Also, it is best to use large fonts with 
this feature as it makes the pattern details more apparent.

By selecting different patterns for each character or selecting other patterns for each line of text, 
it is possible to display a variety of different patterns on a single page. Brush patterns such as 
the gradient spread brushes in the previous example can also be color cycled with the CYCLE 
1-7 option in the PAGE EFFECTS Menu.

TRANSPARENT CHARACTERS

In general, one should create patterned brushes using color 1 through 7 only. Color 0 which is 
normally the genlock video color, should generally not be used in the pattern. However, if Color 
0 is used in the pattern, the corresponding area of the character face will show through to genlock 
video. This can be desireable if you wish to create transparent video characters.

To create transparent characters, simply make a large brash that contains only video Color 0.
This can be done by cutting out a blank (Color 0) area of the screen in a paint package and 
saving it as a brash.

CHANGING THE COLORS OF A BRUSH FROM WITHIN 
BROADCAST TITLER

After typing your patterned text, enter the Main Menu, select LINE, then select PALETTE. As 
you will see, the brash colors for the current line are placed in Color Register boxes 1 through 7. 
These colors can be quickly modified with the Broadcast Titler Palette Menu.

(a) Click on the Color 1 box in the row of 16 color registers.
(b) We will now change Color 1 to Black, and then create a ramped spread to Color 

Register 7. Locate the "V" (value) slider and drag it to the far left using the mouse. 
As you do this, the color in Color Register 1 will darken and turn completely Black.

(c) Now select the SPREAD 1-7 button or press F5 from the keyboard. This will create 
a gradient color spread from Color Register 1, which is Black, to Color Register 7. 
You will also see the patterned text change on the screen to reflect the new gradient 
color values.

(d) Alternatively, some of Broadcast Tider’s built-in spread palettes can be used. To use 
this feature simply click on the PRE-SPREAD button on the left side of the menu or 
press F6 until a desireable palette appears.
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□ LOADING AND PLACING IFF PICTURES ___________
Creating the Picture

1. Create a high resolution IFF picture file using a paint package or digitizer. The picture can be 
the full 16 color 736x480 pixel screen size (736x560 for PAL) or it can be a smaller IFF brush.
If you are going to type text actually on top of the picture, it is best to create an eight color 
picture to prevent color palette conflicts. Hold and Modify (HAM) graphics mode pictures are 
not supported.

2. Copy or save the picture onto the Broadcast Titler sequence disk you will be using.

Loading the Picture into Resident Memory

3. In Broadcast Titler, place the sequence disk in drive DFO. Select FILE from the Main Menu, 
then select LOAD PICTURE. In a moment the Disk Directory Menu will appear listing the 
directories and files on the floppy disk.

4. Select the name of the picture file you wish to load from the Disk Directory. The file will load 
into Broadcast Titter’s Resident Picture Storage, but it will not be displayed.

Displaying a Resident Picture

5. In the Text Edit Mode, move the Text Edit Cursor to the page and line which is to contain the 
Upper-Left portion of the picture.

6. From the Main Menu, select LINE. Then select PICTURE. The Picture Menu appears.

7. Click on the Picture Name button to step through the list of resident pictures.

8. When the correct picture name appears, adjust the LEFT and TOP values to position the 
picture on the page as desired. The position is indicated by a horizontal and vertical marker. The 
actual picture will not appear until the you exit the menu.

9. If you need to readjust the position of the picture, enter the Picture Menu again and change 
the position values accordingly.

Adjusting the Palette

10. Ideally, it is easiest to place background pictures on the page before entering lines of text, 
since the correct color palette for the picture is already in effect for the page.
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However, if you add a full-page picture to a page that already has text, you may find that only the 
top line on the page has the correct color palette for the picture. This is because Broadcast Titler 
assigns the picture and its associated palette to an individual line.

To remedy this, replicate the correct palette over the entire page. Select LINE from the Main 
Menu. Select PALETTE. Move the palette window cursor to the line containing the correct 
palette. Select CUT PAL. Select AFFECT PAGE, then select PASTE PAL. Exit to the Text Edit 
Mode to resume editing.

G SAVING A SEQUENCE
1. To save a sequence onto a disk for later retrieval, one should first have a formatted floppy 
disk on hand if you are not using a hard disk. Make sure that the floppy disk is not 
write-protected, and place the disk in floppy drive DFO.

2. Enter the Main Menu and select FILE. Then select SAVE SEQUENCE. In a moment the 
Disk Directory Menu appears, showing the names of all directories and files on the disk.

3. From the keyboard, type in the name of the sequence you would like to save. The complete 
disk path should also be specified.

As you type, the path and file names will appear in the red DISK PATH box at the bottom of the 
menu. When the name is entered, press RETURN.

Path Examples:

DFO:MyFirstSequence

Work:Video/BTitler2/MyFirstSequence

These examples create a Broadcast Titler Sequence file named "MyFirstSequence.BTS". The 
".BTS" extension is automatically supplied by the program, and designates the file as a sequence 
file.

4. To start a new sequence, select CLEAR SEQUENCE from the File Menu. Type "Y" at the 
"Are You Sure?" prompt. Then type "N" at the "Reload Fonts?" prompt. Or, to exit Broadcast 
Titler, simultaneously press CTRL and ESC while in the Text Edit Mode.

5. Using the CLI or a file transfer utility, copy any IFF picture files used in the sequence onto 
the sequence disk. This is necessary so that Broadcast Titler can easily find and load these 
pictures when the sequence is loaded at a later time.
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If you are going to transfer the sequence to another disk by copying individual files in Amiga 
DOS or a file transfer utility, remember to copy all of the following files:

MyFirstSeq.BTS
MyFirstSeq.LOAD
MyFirstSeq.PICS
Any IFF picture files used in the sequence.
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MAIN RIGHT MOUSE BUTTON

To enter the Text Edit Mode from the Main Menu, click the Right Mouse Button, or press ESC, 
or the Right Amiga key from the keyboard. The menu bar disappears from the bottom of the 
screen to allow full editing of the page.

Most of the basic text editing functions as well as the more advanced page formatting abilities of 
Broadcast Titler are outlined in this chapter.

The sequence effects playback can also be activated front the Text Edit Menu by pressing 
function key FI from the keyboard. Refer to the Play Menu Chapter for information concerning 
other play options.

To exit the Text Edit Mode and re-enter the Main Menu, click the Right Mouse Button, or press 
either ESC or the Right ALT key from the keyboard.

SECTION ONE - CURSOR FUNCTIONS
DEFINING A NEW TEXT LINE

New lines of text are created in the Text Edit Mode by pressing RETURN or the Down Arrow 
key after a line of text has been entered. Pressing RETURN moves the Text Edit Cursor one text 
row lower on the page, and starts a new line of text. The height of this new text line is 
determined by the height of the current font. To make fine adjustments to the new line’s vertical 
position with respect to the previous line, see the following section on Vertical Character 
Positioning.

VERTICAL CHARACTER POSITIONING

Minor adjustments can be made to the vertical placement of characters that you are about to type 
on a line. Simultaneously press SHIFT and Up Arrow to move the Text Edit Cursor up by two 
scanlines, or press SHIFT and Down Arrow to move the Cursor down by two scanlines. This 
technique also provides accurate, user controlled placement for subscripts and superscripts.

DELETING A CHARACTER

To delete the character directly to the right of the cursor, press the DEL key from the keyboard 
(located next to the HELP key on the keyboard).
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To delete the character to the left of the cursor, press the BACKSPACE key from the keyboard 
(located above the RETURN key on the keyboard).

CURSOR MOVEMENT CONTROLS

To move the Text Edit Cursor one character to the right, press the Right Arrow key. To move to 
the left, press the Left Arrow key. The cursor cannot be moved past the Left or Right Page 
Margins, which are controlled from the Layout Menu.

MOUSE PLACEMENT OF TEXT EDIT CURSOR

To quickly place the Text Edit Cursor at any character position on the page, move the Mouse 
Pointer over the desired character, and click the Left Mouse Button. The Text Edit Cursor will 
jump to the selected line and character position. Editing resumes from the new position.

CURSOR JUMP FUNCTIONS

To place the Text Edit Cursor at the beginning of the current text line, simultaneously press 
CTRL and Left Arrow.

To place the Text Edit Cursor at the end the current text line, simultaneously press CTRL and 
Right Arrow.

To place the Text Edit Cursor at the top line of the page, simultaneously press CTRL and Up 
Arrow.

To place the Text Edit Cursor at the bottom line of the page, simultaneously press CTRL and 
Down Arrow.

SECTION TWO - LINE FUNCTIONS

LINE-BY-LINE CENTERING

Any line of text on the page can be aligned with the Left Page Margin, Right Page Margin or it 
can be centered between the two margins. Move the Text Edit Cursor to the line to be centered. 
Simultaneously press CTRL and C. For left justified text, simultaneously press CTRL and L. 
For right justified text, simultaneously press CTRL and R.

A The Layout Menu provides a facility for centering the entire page of text all in one step.
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ADVANCE TO NEXT TAB STOP

Five horizontal Tab Stop positions are available for each page. To place the Text Edit Cursor at 
the first Tab Stop position, press the TAB key once. Pressing the TAB key a second time will 
advance the Text Edit Cursor and any text following it at the second Tab Stop position. The Tab 
Stop locations for the current page may be viewed or changed in the Layout Menu.

Pressing the TAB character from the keyboard actually adds a TAB character to the text line. To 
release a tab position, simply move the Text Edit Cursor to the tab location in the line, and press 
the BACKSPACE key to delete the Tab character embedded in the line.

DELETING TEXT ON A LINE

To delete all text from a line, leaving an empty line in its place, press the DEL key (the decimal 
point key on the Numeric Keypad). This operation only clears text from the line and does not 
remove the line’s space from the page.

REMOVING A LINE

To completely remove a line from the page, moving all lower lines up in position on the page, 
simultaneously press SHIFT and DEL (the decimal point key on the Numeric Keypad).

INSERTING A LINE

To insert a new line of text between two existing lines, place the Text Edit Cursor on the line at 
which you wish to insert. Press the INS key ("0" on the Numeric Keypad). The lines below the 
insertion point will be moved a distance down the page equal to the line height of the current edit 
font.

COPY LINE / PASTE LINE

To copy a line of text into the Text Copy Buffer, move the Text Edit Cursor to the line you wish 
to copy, and simultaneously press CTRL and K.

To paste a copy of the line in the Text Copy Buffer onto the current line, simultaneously press 
CTRL and P.

REPOSITIONING ALL TEXT LINES ON THE PAGE

All of the text lines on the page are positioned relative to the Left Page Margin. Changing the 
Left Page Margin in the Layout Menu will move all lines of text to a new horizontal position.
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Similarly, the vertical placement of all text lines on the page is based on the location of the Top 
Page Margin. Therefore changing the Top Page Margin in the Layout Menu will move all lines 
of text on the page to a new vertical position.

REPOSITIONING A SINGLE TEXT LINE

To move a single line of text after it has been typed, move the Text Edit Cursor to the line to be 
moved. To shift the text line up two scanlines, simultaneously press the SHIFT key and the "8" 
key on the Numeric Keypad.

To shift the text line down two scanlines, simultaneously press the SHIFT key and the "2" key on 
the Numeric Keypad.

To shift the text line to the left, simultaneously press the SHIFT key and the "4" key on the 
Numeric Keypad.

To shift the text line to the right, simultaneously press the SHIFT key and the "6" key on the 
Numeric Keypad.

For more rapid cursor movement, keep holding down the keys until the cursor is near the desired 
position, and then release.

SECTION THREE - CHARACTER FUNCTIONS

COPY CHARACTER ATTRIBUTES

When editing an existing page with multiple fonts and character attributes, it is often desirable to 
be able to "Pick Up" a font style and full character attributes directly from any character on the 
page. Normally these attributes would have to be re-established by the user via the Font Menu.

To take the guesswork out of this operation, simply place the Text Edit Cursor on the Left side of 
the desired character. Then press the Left Amiga key to pick up the attributes of the character to 
the right. These attributes are then established as the current text edit attributes. If desired, these 
new attributes can be viewed in the Font Menu.

PASTE CHARACTER ATTRIBUTES

To plant the current character attributes over existing text having different attributes, place the 
Text Edit Cursor to the Left of the first character to be changed. Simultaneously press the CTRL 
and Left Amiga keys. All characters to the right of the cursor will change to the current 
character attributes.
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CHARACTER KERNING

Broadcast Titler builds special inter-character spacing information, or "Kerning" values into its 
fonts. Kerning improves the appearance of evenly spaced characters by varying the spacing 
between irregularly shaped characters. Broadcast Titler automatically uses kerning in its 
standard fonts, as well as any fonts converted with the Font Converter or the optional Font 
Enhancer.

Without Kerning, the word "To" in a large font will have too much space between the letters "T" 
and "o". This is because standard "Proportional Spaced" characters do not take into account how 
to best position two adjoining characters having different shapes. Whereas with automatic 
Kerning, characters are carefully fitted together based on character shape information. This 
difference is illustrated below.

Kerning No Kerning

CHARACTER TUCK

Although Broadcast Titler provides automatic Kerning, a manual Character Tuck feature is 
provided on a character by character basis for added flexibility. To "Tuck" any two characters 
slightly closer together, place the Text Edit Cursor between the two characters. Press CTRL and 
T simultaneously to Tuck the characters one pixel closer to each other. Larger typefaces may 
require several repetitions of this command to fully close large gaps.

In some cases you may wish to separate two characters without using the SPACE BAR, since a 
SPACE character adds about eight pixels between characters. For finer adjustments, place the 
Text Edit Cursor between the two characters to be separated. Press CTRL and S simultaneously 
to "micro-space" the characters one pixel at a time.

SQUEEZING IN EXTRA CHARACTERS ON A LINE

Additional characters may be added to a full line of text by pressing SHIFT and Left Arrow 
simultaneously. The command will need to be repeated several times. By holding down the 
keys continuously the auto-repeat feature will speed up the process. Each time this command is 
entered it reduces by one pixel the space between ALL characters on the line. The characters 
seem to squeeze together, providing more room at the end of the line for additional characters.

The opposite effect is obtained by simultaneously pressing SHIFT and Right Arrow. The space 
between EACH character on the line is increased by one pixel.
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Another alternative for adding more space on the line is to extend the Left and Right Page 
Margins in the Layout Menu. However, one must be careful not to extend the margins beyond 
the Safe Titling Area. Otherwise some characters may not be visible on all Televisions or 
Monitors.

THE UNDERLINE MODE

CHARACTER BY CHARACTER UNDERLINING

Broadcast Titler provides a character-by-character underlining function which is incorporated 
into Broadcast Titler’s Text Edit mode. To underline a word or any set of individual characters 
on a line, enter the Text Edit mode and move the Text Edit Cursor to the desired text line. Type 
an underline character by holding down the SHIFT key while pressing the underline/hyphen key 
on the keyboard (Next to the "+" key). The red Underline Menu will appear at the bottom of the 
page.

Notice also that a small red underline cursor appears at the left margin of the current text line. 
This is the Text Underline Cursor which is used to select the starting position for the text 
underline. With the Text Underline Cursor placed at the left edge of the word to be underlined, 
type in the underline by repeatedly pressing the SHIFT-UNDERLINE key from the keyboard. 
With each underline character typed, the underline cursor will advance one position to the right 
and leave behind a solid underline. Type all the way across to the end of the underlined word. If 
satisfied with the underline as it appears, type one additional underline character, and press ESC 
from the keyboard to return to the Text Edit mode.

MAKING CHANGES TO THE UNDERLINE

While in the Underline Mode, the underline may be erased by pressing the BACKSPACE key 
from the keyboard, or by placing the Underline cursor over the underline section to be erased and 
pressing the SPACE BAR. Removing all underlines from the current text line is done by 
pressing the DEL key from the keyboard.

UNDERLINE VERTICAL POSITIONING

To move the underline up, press the Up Arrow key from the keyboard while in the Underline 
Mode. To move underline down, press the Down Arrow key from the keyboard. The new 
vertical position will be represented by the Text Underline Cursor only. The rest of the underline 
will remain in the old position until you return to the Text Edit mode and the page refreshes 
itself.
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CHANGING THE THICKNESS OF THE UNDERLINE

In the Underline Mode, press the "H" key from the keyboard to increase the height of the 
underline, or press "h" to decrease the height of the underline. The underline height will be 
reflected only by the height of the Underline Cursor itself. The actual underline will be 
displayed correctly upon returning to the Text Edit mode when the page refreshes itself.

DOUBLE UNDERLINES

One interesting variation of the standard underline is a double underline which is obtained by 
setting the underline height to a thickness of ten scanlines or greater. The text underline cursor 
will appear to split into two separate underlines, one on top of the other. To return to the single 
underline style, press the lower case "h" from the keyboard until the text underline cursor 
becomes a single underline.

CHANGING THE UNDERLINE COLOR

The underline color can be changed by altering Color 4 from the Palette Menu. The underline 
shadow takes on the same color and dimension as the character shadow for the text line.

INTERNATIONAL AND SPECIAL CHARACTERS □
The following keystroke sequences will generate an accent mark on the letter typed. For 
example an is generated by simultaneously pressing the Left ALT and "G" keys together, 
releasing both keys, and then pressing the "a" key.

ALT G THEN RESULT

ALT G A A
ALT G a k

ALT G E fe
ALT G e b

ALT G I i
ALT G i \

ALT G 0 6
ALT G 0 6

ALT G U
Vu

ALT G u u
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The following keystroke sequences will generate a n " accent mark on the letter typed. For 
example an "d" is generated by simultaneously pressing the Left ALT and "F" keys together, 
releasing both keys, and then pressing the "a" key.

ALT F THEN RESULT

ALT F A A
ALT F a d

ALT F E t
ALT F e 6

ALT F I t
ALT F i i

ALT F O 6
ALT F o 6

ALT F U u
ALT F u u

The following keystroke sequences will generate an "A" accent mark on the letter typed. For 
example an "a" is generated by simultaneously pressing the Left ALT and "H" keys together, 
releasing both keys, and then pressing the "a" key.

ALTH THEN RESULT

ALTH A A
ALTH a a

ALTH E
Ai

E
ALTH e e

ALTH I
A

I
ALTH i A1

ALTH O
a

O
ALTH 0 6

ALTH U
A

U
ALTH u Au
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The following keystroke sequences will generate an umlaut accent mark on the letter typed. For 
example an "a" is generated by simultaneously pressing the Left ALT and "K" keys together, 
releasing both keys, and then pressing the "a" key.

ALT K THEN RESULT

ALTK A A
ALT K a a

ALTK E E
ALTK e e

ALTK I I
ALTK i i

ALTK 0 0
ALTK 0 6

ALTK U U
ALTK u ii

The following keystroke sequences will generate a tilde accent mark on the letter typed. For 
example an "n" is generated by simultaneously pressing the Left ALT and "J" keys together, 
releasing both keys, and then pressing the "n" key.

ALT J THEN RESULT

ALT J A A
ALT J a a

ALT J N N
ALT J n n

ALT J O 6
ALT J o 8
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The following special characters are generated by simultaneously pressing the ALT key and the 
indicated letter. For example to generate the"®" character, simply press the Left ALT key and the "a" 
key simultaneously. Many of the following special symbols are included with the NTSC version.

ALT PLUS RESULT ALT PLUS RESULT

ALT A M ALT S §
ALT a ® ALT V a
ALT B s ALT w •

ALT C c ALT y □
ALT c 9 ALT Y ¥
ALT E © ALT z ±
ALT i i ALT Z -i
ALT L £ ALT 1 1
ALT M i ALT 2 2
ALT N — ALT 3 3
ALT O 0 ALT 4 0
ALT 0 0 ALT 5 1/2
ALT P 1 ALT 6 1/4
ALT Q A ALT 7 3/4
ALT q & ALT 8 •
ALT R ® ALT 9 «
ALT s 6 ALT 0 »

▲ A special opening quote character is obtained by pressing SHIFT - BACKSLASH.

A In the interest of saving space in Resident Font Storage, the NTSC version of the program 
contains Special Symbols, but does not contain the International Accented Characters. The PAL 
version of the program contains the full set of International Characters and the Special Symbols.

If you need accented characters for the NTSC version, contact InnoVision Technology directly 
for ordering information. A total of 1.5 megabytes of FAST RAM and 512 kilobytes of CHIP 
RAM is required for the extended fonts.

If you own Amiga Fonts containing the full ASCII 256 International Character Set, then the Font 
Converter and the optional Font Enhancer will convert all of the characters contained in the font. 
See the Font Converter documentation in the Appendix of this manual.

Since Broadcast Titler supports International Keymaps and the full ASCII 256 character set, it 
possible for users to define their own special characters in an Amiga Font editor. Simply convert 
the resulting font in the Font Converter or the optional Font Enhancer for use in Broadcast Titler. 
Most special characters currently used are located in the range of characters ASCII 160 through 
ASCH 191.
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SECTION FOUR - PAGE FUNCTIONS
HELP KEY PAGE REFRESH

Some editing operations, such as vertical shifting of characters, and deleting or inserting lines 
require that the page be redrawn periodically to insure that the display is accurate and up to date. 
To refresh the page press the HELP key from the keyboard.

CREATING A NEW PAGE

To add a new page to the end of a sequence, simultaneously press SHIFT and PgDn ("3" on the 
Numeric Keypad). A new blank page will be created and the Text Edit Cursor will appear on the 
top line. This same command is also available in the Main Menu.

A convenient menu-driven selection for both Appending and Inserting pages is provided in the 
Page Menu. See that chapter for further details.

MOVING TO ANOTHER PAGE

The following commands access other pages in the sequence:

PgUp - Jump to the previous page
PgDn - Jump to the next page
HOME - Jump to page one
END - Jump to the last page in the sequence
SHIFT PgDn - Create a new page at the end of the sequence

These commands are also active in the Main Menu. In addition, the Main Menu also provides 
direct entry of page numbers for random access capability. In addition, the Page Menu provides a 
convenient means of accessing pages by listing ten pages at a time. See the Main Menu and Page 
Menu chapters for details.

INSERT / COPY / MOVE / DELETE PAGE

For simplicity and ease of use, these page-handling functions are accessed in the Page Menu. See 
the Page Menu Chapter for a complete explanation of these functions.
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I  CHAPTER 5
□ T O E  M/MM i

The Main Menu is the central control point for most of the non-text editing functions available in 
Broadcast Titler. The Main Menu provides rapid access to most of the common editing, layout 
and disk functions used in Broadcast Titler.

From this Menu, the FONT MENU provides access to font selection and character attribute 
settings.

The LINE MENU assigns individual functions or characteristics for a particular line of text on a 
page, such as effects, palette changes, IFF backgrounds, and patterns.

The PAGE MENU selection is used to edit the ordering, layout, effect, and palette for each page 
in the sequence. It also provides numerous editing functions for moving, deleting and inserting 
pages.

The PLAY MENU is a special menu that customizes the manner in which the sequence is 
played back. As a convenient shortcut, some of these playback functions are also available in the 
Edit Mode and Main Menu as keyboard commands. A Screen Options Menu is also included in 
the Play Menu for adjusting the screen offset and displying the status bar for users of the Manual 
Play feature.

The FILE MENU is used for selecting mass storage operations on floppy or hard disk drives. 
This includes loading and saving sequences and pictures, and loading fonts and ASCII text files 
into a sequence.

JUMPING TO ANOTHER PAGE

The Main Menu allows you to jump to any page in the sequence. To move to the previous page 
in the sequence, select the PAGE UP button from the menu or press the PgUp button (numeric 
keypad 9) from the keyboard. To move to the next page in the sequence, select the PgDn button 
or press PgDn (numeric keypad 3) from the keyboard. To jump to the first page in the sequence, 
select the H (Home) button or press HOME (numeric keypad 7) from the keyboard. To jump to 
the end of the sequence, select the E (End) button on the menu or press END (numeric keypad 1) 
from the keyboard.
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RANDOM PAGE ACCESS FROM THE MAIN MENU

In the Main Menu, random access to any specific page in the sequence is accomplished by typing 
the desired page number from the keyboard which will call up the specified page. Type 01 for 
page one , 02 for page two, etc. If your sequence contains more than 99 pages, then a three digit 
number must be typed, i.e. 001,050, 250 etc.

APPENDING A NEW PAGE

Appending a new page to the sequence is accomplished by pressing and holding down the 
SHIFT key and then pressing the PgDn key (keypad 3) from the keyboard. This can also be done 
through the Page Menu. The SHIFT-PgDn combination prevents the accidental addition of 
unwanted blank pages at the end of your sequence.

RETURNING TO TEXT EDIT MODE

To return to the Text Edit mode for the current page, press the Right Mouse Button or press ESC 
from the keyboard. The Text Edit cursor will reappear and you can resume typing and editing. 
Press the HELP key from the keyboard. To access the Main Menu from the Text Edit entry 
mode, click the Right Mouse Button, or press ESC or the Right ALT key from the keyboard.

EXITING BROADCAST TITLER

To exit the program and return to the AmigaDos Workbench or the Auto-Boot menu, 
simultaneously press CTRL and ESC from the Main Menu.
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I  CHAPTER 6
□ toe mm HEGW

MAIN >  FONT

The Font Menu contains a number of character attribute options such as the following:

- Selecting a Font
- Changing the Face Color for text entry
- Adjusting Shadows & Outlines
- Switching the Anti-alias setting
- Selecting the Pattern Filled Text option

CHOOSING A FONT

Move the cursor to the RESIDENT FONTS button on the menu. The current font name is 
displayed in this button along with its size in scanlines. The actual font and selected style is also 
displayed on the bottom of the menu by the letter "A”.

Click on the Right side of the RESIDENT FONTS button to advance through the list of available 
fonts until the new font you desire appears. With each click, the letter "A" at the bottom will be 
displayed in the new font style. To go back to the previous font, click on the Left side of the 
RESIDENT FONTS button.
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If the font you desire is not listed in the set of resident fonts, you probably have not loaded the 
font from the File Menu. Only the fonts that have been loaded at the start of the program from 
the BTFONTS.LOAD file, and those loaded directly from the Load Font menu will be displayed 
in the resident font list. See the FILE MENU chapter for details on loading additional fonts.

CHANGING THE SHADOW SIZE

The shadow size is a line-by-line attribute that specifies how far the shadow will extend from the 
face of the character. To increase the size of the shadow, move the mouse pointer to the right 
side of the number in the SHADOW SIZE box, and click the Left Mouse Button. The value for 
the shadow will increase by two scanlines for each click of the mouse button. The maximum 
shadow size is 32 scanlines.

To decrease the size of the shadow, click on the left side of the shadow size number and the 
value will decrease by two. To remove the shadow, set the value to zero. As with most numeric 
boxes on the Broadcast Titler’s menus, it is possible to enter a value directly by highlighting the 
SHADOW SIZE box, typing in the desired value, and pressing RETURN.

CHANGING SHADOW DIRECTION

The character shadow direction is another line attribute. There are eight shadow directions from 
which to choose. Click to the left or right of the shadow direction arrow to rotate through the 
eight shadow direction settings.

SELECTING CAST OR SOLID SHADOWS

There are two types of shadows available for characters. The standard setting is for a Solid 
shadow which makes the character look like it was carved from a solid block. By clicking on the 
SHADOW/CAST button, the shadow can be changed to a Cast shadow which gives the 
impression that the shadow is being projected onto the background of the page.

The distance between the face and the cast shadow is controlled by the SHADOW SIZE 
attribute. The larger the number, the farther from the face the cast shadow will appear. In 
addition, the shadow direction determines the apparent light source for the cast shadow.

SETTING THE CHARACTER OUTLINE SIZE

The character outline is a line attribute controlling the size and style of the character oudine. To 
make characters stand out from the background video, it is common practice to place a black 
outline and shadow around alphanumerics used in video production. Also, text with outlines or 
shadows tends to be easier to read.
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To change the Outline Size, move the mouse pointer into the OUTLINE SIZE button and click to 
the right of the OUTLINE SIZE number to increase the size, or to the left of the OUTLINE 
SIZE number to decrease it. You may also enter a value from 0-6 via the keyboard, and press 
RETURN.

SETTING THE OUTLINE STYLE

Normally, the Outline is in the STANDARD setting which draws an outline around the face of 
the character. The other option is the HIGHLIGHT Outline in which both the face and the 
shadow are completely surrounded by the outline.

In order for the HIGHLIGHT style to display correctly, the Outline Size must be "1" or greater, 
the Shadow Size must be "2" or greater, and palette color 8 (SH) should be set to a different 
value than color 12 (OL).

CHANGING THE FACE COLOR

The face color is a character-by-character attribute. For standard text, there are four pre-assigned 
color groups which permit up to four anti-aliased face colors per line of text. The standard color 
used for the character face is color 14.

To change the color used for the face of the characters you are about to type, click inside the 
FACE COLOR box to change the face color to a value of 2 ,6 ,10 or 14.

▲ If you are using background patterns or IFF pictures in your pages, it is recommended that 
face color 10 or face color 14 be used for text. This is because background patterns or IFF 
pictures using colors 1 through 7 may interfere with the anti-alias colors for color 2 or color 6 
text.

CHARACTER ANTI-ALIASING

The Anti-alias character attribute button is provided as a means of turning on and off the 
automatic anti-aliasing feature within Broadcast Titler. In order for Broadcast Titler’s 
anti-aliasing to work correctly, one should be sure that the anti-alias option is set to
ANTI-ALIAS.

A Only Broadcast Titler’s default fonts and fonts converted with the optional Broadcast Titler 
Font Enhancer contain anti-aliasing. Amiga Fonts that have been brought into Broadcast Titler 
through the Font Converter package provided with Broadcast Titler will not have anti-aliasing, 
regardless of the Anti-alias attribute setting.
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BRUSH PATTERN TEXT FILLS

Aside from the standard single-color face characters, Broadcast Titler provides a means of 
mapping user created eight-color pictures or patterns on top of plain characters. This feature 
uses brush colors 0 through 7 as the colors for the face pattern.

To use this feature, one must first create a pattern in a paint package or digitizing program in up 
to eight colors. Details covering this procedure are provided in the Text Fill Tutorial in Chapter 3.

If multiple eight-color face patterns have been loaded into Broadcast Titler, the desired face 
pattern may be selected by clicking in the face pattern box to cycle through the available IFF 
brush pattern names that have been loaded into resident memory.

With each click of the mouse button, the next face pattern will become visible in the character 
preview window at the bottom of the menu. To return to the normal single-color text mode, click 
on the face pattern box until the name "SOLID" appears.

HIGH RESOLUTION/SUPER HIGH RESOLUTION MODES

Normally Broadcast Titler will operate in the "High Resolution" 16 color, 70 nanosecond, 736 x 
480 pixel graphics mode. With die advent of the Amiga 3000, and the new Super High 
Resolution Denise video chip upgrade for Amiga 500,2000, and 2500 Broadcast Tider now 
offers an optional 35 nanosecond "Super High Resolution" upgrade which will allow you to take 
advantage of the Amiga’s new and improved resolution capabilities.

The Broadcast Tider Super High Resolution Upgrade increases the number of actual horizontal 
screen pixels from 736 to 1,472. This gives Broadcast Tider characters a very sharp look that 
rivals the best high-end character generators on the market today. Broadcast Tider also adds its 
own anti-aliasing to these characters to improve the resolution even further.

If you have purchased the Broadcast Tider Super High Resolution Upgrade, the MODE button 
will have two settings. By clicking on the MODE button, the Super High Resolution character 
mode will be invoked. This is a line-by-line attribute in which all characters on a single line are 
displayed in either High Resolution 70 nanosecond mode, or 35 nanosecond Super High 
Resolution mode.

As a line attribute, the Super High Resolution mode may be interspersed with standard High 
Resolution lines on the same page. This can be useful for displaying 16 color digitized images, 
while displaying text in lines above or below using the sharper Super High Resolution mode.
The Super High Resolution mode is limited to only 4 colors per line, although Broadcast Tider 
allows a new 4 color palette for each text line on the page, providing a total of up to 64 Super 
High Res colors per page.
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A If you are interspersing High Resolution lines with Super High Resolution lines on a page, 
you may occasionally notice a single scanline fringe pattern effect that appears ort the first 
scanline of a High Resolution to Super High Resolution boundary. This is not a serious problem 
as it involves only color zero, which is normally genlocked, and will not be displayed in the final 
video output.

This visual artifact only appears if you are mixing Super High Resolution and standard resolution 
lines, and is caused by the Amiga’s Multiplexed Hardware implementation of the Super High 
Resolution color palette.

This artifact can be eliminated by setting the background color 0 to a full Black value (R=0,
G=0, B=0).

A It is important to keep in mind that pages containing Super High Resolution lines must use 
one of the designated Super High Resolution effects. Normally this distinction is automatically 
handled by Broadcast Titler, which selects the appropriate effect based on the resolution used for 
the page.
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CHAPTER 7
TOE QJIN1E MEMU
MAIN > •  LINE

The Line Menu provides the following operations on a line-by-line basis:

- Selecting Line Effects
- Changing Line Palettes
- Placing Pre-loaded IFF Picture Backgrounds or Brushes
- Creating & Placing Line Patterns

The current line being edited is marked by the yellow Text Edit Cursor on the left side of the 
menu. To move to another line on the page, select the LN UP or LN DN Arrow buttons on the 
menu, or press the UP or DOWN Arrow keys from the keyboard. The Text Edit Cursor will 
move to the new line.

THE LINE EFFECT MENU

MAIN > -  LINE > -  EFFECT

During playback, each new page of a Broadcast Titler sequence is introduced by a transition 
effect. Those effects that move the entire page as a single unit are called PAGE TRANSITIONS, 
and are discussed in the PAGE MENU chapter.

The other class of effects that introduce the next page’s text one line at a time are called LINE 
TRANSITIONS, which are explained in this section.

Each line on a page may contain a different line transition. This capability lends itself to creating 
numerous customized transitions that can appear to animate selected areas of the page.

To add line transitions to a page, select LINE from the Main Menu. Select EFFECT to enter the 
Line Effect Menu.
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LINE EFFECT DESCRIPTIONS

Cut - Instantaneously displays the current line with no special effects.

Teletype - "Types" each character one at a time from left to right on the current line.

Slide - Slides in the current line over the previous line from the direction specified.

Ease - The current line rapidly accelerates toward the direction specified, then gradually 
decreases speed as it gets closer to the center.

Wipe - Horizontally wipes the current line over the previous line.

Spread - The current line is wiped onto the screen either from the center to the left and right 
edges (Spread In) or from the edges to the center (Spread Out)

Random Stripes - Randomly places thin vertical strips of the current line onto the previous line. 

Stripes - Thin vertical slices of the image are layered onto the screen.

Fade Black - All colors on the previous line gradually decrease to Black, then the current line 
fades from Black.
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Fade Color 0 - All colors on the previous line gradually blend into the shade in Color register 0, 
then the current line fades in.

LINE EFFECT MAP

1 Cut
2 Teletype
3 Slide Left
4 Slide Right
5 Ease Left
6 Ease Right
7 Slide Up
8 Slide Down

9 Wipe Left
10 Wipe Right
11 Spread In
12 Spread Out
13 Random Stripes
14 Stripes
15 Fade Black
16 Fade Color Zero

CHOOSING A LINE TO PLACE AN EFFECT

Locate the LN UP and LN DN buttons on the lower left of the menu. This is the current line 
selector. Just to the right are the current line number and the text contained on the line.

Each time you move to a new line in the Line Effect Menu, the line effect data for the new line is 
displayed in the menu buttons. The current line effect is highlighted from the Line Effect List at 
the top of the menu. Clicking on another effect name in the list will select that line effect for the 
current line. From the keyboard, highlight the Effect Name Button on the bottom of the menu, 
and press the UP or DOWN Arrow keys until the desired effect name appears.

SETTING THE SPEED OF THE EFFECT

Each line effect can be set to execute at nine different playback speeds, with speed 1 being the 
slowest, and speed 9 the fastest. After selecting the desired effect, highlight the SPEED button. 
Click to the left of the speed value to decrease the speed, or to the right of the number to increase 
the speed. From the keyboard, the UP and DOWN Arrow keys are used to change the SPEED 
value. In addition, die SPEED value may be typed in directly from the keyboard and entered by 
pressing RETURN.

SETTING THE "ORDER" FOR LINE-BY-LINE EFFECTS 
PLAYBACK

Each line on the page can transition onto the screen in any order of appearance. The ORDER 
value controls the order in which the lines will appear. Setting the ORDER value on a line to "1" 
will make that line the first line to appear on screen. This line will move onto the screen and 
then hold in position. Only after the first line has completed its move will the next line, with 
ORDER "2" begin to move onto the screen, and so forth.
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These are called line-by-line transitions since only one line transition is executing at a time. Be 
aware that the initial ORDER value for each line on the page is automatically set to ORDER "1", 
which is the setup for the Simultaneous Playback mode covered in the following section. 
Therefore to achieve Line-By-Line Playback you must set the ORDER value for each line to a 
different numeric value.

SHARING THE SAME "ORDER" FOR SIMULTANEOUS 
EFFECTS

Simultaneous line transitions move lines having the same ORDER value at the same time. If two 
or more lines have the same ORDER value, then those lines will begin their transitions all at the 
same time. For example, if three lines on the page have an ORDER value of "1", then those 
three lines will begin to move all at once. Only when these three lines have finished moving will 
any remaining lines with ORDER values of "2" or greater begin to execute.

▲ The first time you enter the Line Effect Menu, all lines on the page already have an ORDER 
value of "1", so they will default to simultaneous playback.

USING "DELAY" FOR STAGGERED START OF 
SIMULTANEOUS EFFECTS

Expanding on the discussion of Simultaneous Effects from above, it is sometimes desirable to 
add a timed delay before starting a line effect. As just stated above, all line effects sharing the 
same ORDER will allow those lines to move at the same time. By adding an additional DELAY 
control, any line can be made to start moving a set number of video fields later.

If all of the line DELAY times are set to "0.00", then each line effect will start and finish at the 
same time. While a DELAY of "0.10" for one of the lines will cause that line effect to lag 
slightly behind other lines.

The WEAVE Page Effect is a working example of this concept. Each line of the WEAVE Page 
Effect is set up to alternate between a SLIDE LEFT or SLIDE RIGHT line transition. All of the 
lines for this effect are automatically set to ORDER "1" so that they can move at the same time. 
However, staiting from the top line on the page, each successive line going down the page has a 
progressively longer DELAY value. The first line has a DELAY of "0.00". The second line has 
a DELAY of about "0.10", and the third "0.20", etc. During playback, each line appears to start 
moving just a little bit later than die previous one. This gives the staggered start appearance for 
the effect.

The amount of time that the page will "hold" on the screen must be set in the HOLD box in the 
Page Menu. The KEEP OLD PAGE feature in the Page Menu may also have to be adjusted to 
create certain effects.
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LIMITATIONS OF SIMULTANEOUS LINE EFFECTS

A majority of the Broadcast Titler line transitions can be set to run at the same time so that 
multiple lines of text may move, even in different directions, all at the same time. The WEAVE 
Page Effect is an example of a series of line SLIDE effects running simultaneously.

However, some other line effects require a greater amount of real-time processing power, and 
cannot be run with other effects at the same time.

For this reason the following effects will only run one-at-a-time:

* SLIDE UP and SLIDE DOWN effects cannot be run at the same time.
* The TELETYPE effect does not mn with other simultaneous effects.
* WIPE, SPREAD, STRIPE and RANDOM effects will only mn one-at-a-time.

__ | THE PALETTE MENU |________________________
MAIN PAGE > -  PALETTE 
or MAIN > »  LINE > -  PALETTE

The Broadcast Titler Palette Menu is a convenient tool for manipulating or copying color palettes on 
any line or page of a Broadcast Titler sequence. There are 16 different colors available on each line of 
text or graphics on a page. Normally the Amiga video hardware can display a maximum of 16 colors 
on the entire page. Broadcast Titler extends this capability by allowing each line of text on a page to 
be displayed with a different set of 16 colors, providing up to 320 colors per page.

CHANGING COLORS ON A LINE OR PAGE

If you wish to change colors only on a specific line, select the AFFECT LINE option on the bottom of 
the Palette Menu. Individual color palette changes can then be made on a specific line of text.
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If you wish to change a color over the entire page, then select AFFECT PAGE before making 
any changes to the color palette. This will automatically update the entire page with new color 
changes you make.

▲ Upon entry into the Palette Menu the AFFECT LINE option is always selected since most of 
the time you will probably want to change colors on a specific line. To change colors over ALL 
lines on a page, select AFFECT PAGE.

PALETTE MENU KEYBOARD COMMANDS

If you are using Broadcast Titler from the keyboard without using the mouse, the Palette Menu 
functions can be accessed via the following keystroke commands.

LEFT and RIGHT ARROW KEYS highlight the next color box. (This is the same as 
clicking on a color box.)

UP ARROW moves the text cursor to the next higher color window.
DOWN ARROW moves the text cursor to the next lower color window.

"R" increases the Red value for the edit color.
"r" decreases the Red value for the edit color.

"G" increases the Green value for the edit color.
"g" decreases the Green value for the edit color.

"B" increases the Blue value for the edit color.
"b" decreases the Blue value for the edit color.

"H" increases the Hue value for the edit color.
"h" decreases the Hue value for the edit color.

"S" increases the Saturation value for the color.
"s" decreases the Saturation value for the current color.

"V" increases the Value or brightness of the current color.
"v" decreases the Value or brightness of the current color.

"U" undoes changes to the edit color.
"C" cancels all changes to the color palette.

"T" increases the height of the current color window.
"t" decreases the height of the current color window.
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CHANGING THE TEXT FACE COLOR

To change the face color of text that has already been typed on the screen, enter the Palette 
Menu. Select AFFECT LINE if you wish to change only the text color on a single line.
Otherwise select AFFECT PAGE to change the text color over the entire page. Click on the LN 
UP or LN DN button on the left side of the menu to bring the desired text lines into view. The 
yellow text cursor will indicate the current line that is being modified. Each line on the page has 
an independent 16 color palette. As the yellow text cursor moves up and down the page, the 
color register boxes in the menu will reflect the individual palette for the current text line.

Locate the row of 16 color register boxes near the top of the menu. TTiese boxes represent Color 
Register 0 on the left through Color Register 15 on the right. These registers show the 16 color 
palette that is in effect for the current text line. The color boxes are labeled with numbers or 
abbreviations for special purpose colors. For example the "SH" color indicates the color position 
used for the Character Shadow. The "OL" box indicates the color position used for the Outline 
Color. The "FA" box denotes the current text Face Color.

To change the Face Color move the mouse so the mouse pointer is over the color register box 
labeled "FA". Now using the left mouse button, click inside the "FA" color box. Notice that a 
small White arrow is now pointing at the "FA" color box.

Move the mouse pointer down into the Red, Green and Blue slider boxes. These slider boxes 
represent the 16 levels of intensity for the Red, Green and Blue video beams. By sliding the Red, 
Green and Blue indicators it is possible to obtain any of 4,096 available colors.

For example, to create Green colored text, simply slide the Red level indicator to the far left, and 
do the same for the Blue level indicator. Then slide the Green indicator to a Value of 
approximately 12.

USING THE HUE SLIDER AS A QUICK COLOR PICKER

If you wish to create a new color but are not sure which Red, Green and Blue combination is 
needed to achieve the color, then select the (H)ue slider, and drag it from side to side to view a 
wide spectrum of shades. To get the widest possible range of colors, slide the (V)alue indicator 
to the far right before changing the Hue. This method provides a rapid color selection capability 
using only a single control. Using the Hue control is analogous to selecting the general 
chromatic value from a rainbow spectrum.

USING THE SATURATION SLIDER TO MAKE PASTEL SHADES

Once this chromatic base color has been selected, using the (S)aturation slider allows this color 
to be altered by adding or subtracting White from this color. This saturation control gives a wide 
range of pastel color effects to any selected color, and is analogous to adding White paint to 
another color of paint.
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USING THE VALUE SLIDER AS A BRIGHTNESS CONTROL

To change the brightness of the color, click the on the (V)alue slider and drag it from left to right. 
This has the effect of changing the brightness of the color by adding or subtracting Black from 
the color.

▲ Note that as you make changes to a color, the changes are shown in the text window as well.
In addition, the anti-alias levels are also updated automatically to smooth out text jaggies. These 
anti-alias levels are the two colors located to the left and to the right of the Face Color "FA" 
register.

CHANGING A LINE’S COLOR WINDOW HEIGHT

Each line of text in Broadcast Titler is capable of displaying a separate 16 color palette out of a 
total 4,096 available colors. This effectively increases the total number of colors that can be 
displayed on a single page from 16 to 320 colors. There are situations in which the boundaries of 
the separate color "windows" come into play, particulary in the case of line transitions and in 
special colorizing effects.

When you type text on the page, each line of text is contained within a color window that is 
about the same height as the current line of text. Adjustments to the line’s color window can be 
made through the Palette Menu’s LINE HEIGHT control, which is located on the upper right 
portion of the menu.

Simply select the LN UP or LN DN buttons to pick the line whose height you wish change.
Then move over to the HEIGHT Control boxes and select the UP box to bring the bottom of the 
current line’s color window closer to the top of the screen. To increase the height of the color 
window click on the DOWN ARROW HEIGHT box.

Note that with each click of the box, the height of the current line is displayed numerically in 
scanline increments. This allows for easy comparison of line heights on a page and between 
pages.

▲ Line transitions use these color window boundaries as the cut-off point for each line effect. It 
may be necessary to adjust these line heights as desired to compensate for extra-long character 
shadows, or if mixed font sizes are used on a line, to insure that the proper text and graphics area 
is included in each line transition.

COPYING AND MOVING A COLOR

To copy a single color from one line to another line, simply enter the Palette Menu and select 
AFFECT LINE. Select the LN UP or LN DN buttons until the text cursor is on the line 
containing the color you wish to copy.
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Select the individual color you wish to copy from the palette by clicking on the color box for that 
color. Select CUT COLOR, or press F3 from the keyboard which copies the specific color just 
chosen into the copy buffer.

Select LN UP or LN DN to move to the line on which you wish to paste the new color. Select 
PASTE COLOR or press F4 from the keyboard. The new color will be copied over the old 
color, and the new color scheme will be displayed in the Palette Menu’s text window.

COPYING AND MOVING PALETTES BETWEEN LINES AND 
PAGES

To copy the entire palette of sixteen colors from one line to another line, go to the Palette Menu 
and select AFFECT LINE. Select LN UP or LN DN to move the text cursor to the line 
containing the palette you wish to copy. Select the CUT PAL button or press FI from the 
keyboard. This will copy the contents of the sixteen color palette into the copy buffer.

Next select LN UP or LN DN to move to the line over which you wish to paste this new color 
palette. Select PASTE PALETTE or press F2 from the keyboard. This copies the palette 
contained in the copy buffer over the current line’s palette. The color changes will be displayed 
in the text window.

CREATING COLOR PALETTE SPREADS

This option provides a way of generating a sequence of seven colors that gradually blend 
between any two colors of your choice. To use this feature simply click on Color register 1. The 
White arrow will point to this box. Change the Red, Green and Blue values of this color to the 
starting color to be used in the spread. Select CUT COLOR or press F3 from the keyboard.
Click on color box #7. Select PASTE COLOR or press F4 from the keyboard. Color 1 and 7 are 
now the same. From this point, the following steps illustrate how to create three different types 
of color spreads.

A. HUE SPREAD
With Color 7 still highlighted, use the mouse to drag the (H)ue slider from left to right to alter 
the Hue of Color 7. Doing this changes the hue between the two colors, while they share the 
same Value and Saturation.

To complete the spread select the SPREAD 1-7 box or press F5 from the keyboard. Colors 1 
through 7 will now contain a gradient spread ranging from Color 1 through 7.

B. SATURATION SPREAD
With Color 7 selected from the previous example, drag the (S)aturation slider to add or subtract 
White from the color. Move the slider at least half the width of the slider bar so that enough 
gradient steps are available for the spread. Now Color 1 and Color 7 are related to each other in
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both Hue and Value, but have a different Saturation. Color 1 and Color 7 appear to be pastel 
shades sharing the same Hue.

To complete the spread, select SPREAD 1-7 or press F5 from the keyboard. The color registers 
will show the new spread and all in between shades in the text window.

C. VALUE SPREAD
With Color 7 selected, drag the (V)alue slider about half the width of the slider bar. This will 
lighten or darken the selected color by adding or subtracting Black. Be sure to slide the V slider 
at least half the length of the slider bar in order to guarantee that there are enough steps between 
the two colors to make an effective spread. To complete the spread select SPREAD 1-7 or press 
F5 from the keyboard.

A These color spreads are used in conjunction with IFF Picture Backgrounds and Line Patterns 
that are found in the Line Menu. These line patterns use Colors 1 through 7 to achieve gradient 
fills, spreads, cylindrical bars, and Pattern Filled Text.

It is important to note that if no patterned backgrounds, IFF pictures, or patterned characters are 
used, the color spreads outlined here will not appear on the screen since these colors have not 
been used. All the patterns in Broadcast Titler, as well patterned characters, are designed to use 
the full range of colors from Color 1 through Color 7 to achieve their color effects. Colors 1 
through 7 are also used for the Color Cycle page effect.

USING PRE-DEFINED COLOR SPREADS

A number of interesting pre-defined gradient color spreads using Colors 1 through 7 have been 
included in the program. They work particularly well with background patterns and pattern filled 
characters. To access these color spreads, click on the PRE-SPREAD button or press F6 from 
the keyboard. With each click on the button, a new color spread will appear in Colors 1 through 
7. Once you have selected the correct palette, press the Right Mouse Button or press ESC to exit 
the Palette Menu.

AUTOMATIC ANTI-ALIASING / MANUAL COLOR CONTROL

Color palette boxes 2,6,10, and 14 provide four different Face Colors for text. These four Face 
Colors can be selected through the Font Menu. In order to maintain proper anti-aliasing for text, 
Broadcast Titler employs an automatic anti-aliasing feature which adjusts the two colors adjacent 
to the Face Color so that they contain the proper anti-alias color values. If the Face or Outline 
Colors are changed through the Palette Menu, the associated anti-alias levels will be changed as 
well.

However there are situations in which it is desirable to modify any of the colors in the palette 
without allowing die automatic anti-aliasing feature to adjust other colors in the palette. Only the 
color you are trying to change will actually be changed. To disable the automatic anti-alias
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feature simply select MANUAL CONTROL/ANTI-ALIAS or press F7 from the keyboard to 
display the MANUAL CONTROL option. While MANUAL CONTROL is displayed, any color 
in the palette can be changed without invoking the automatic anti-alias color changes. When 
your changes are complete, you may wish to restore the anti-alias mode so that any future 
changes to the Face Color of your text will use the automatic anti-alias feature.

UNDO/CANCEL

If you make a mistake while in the Palette Menu and wish to change the current color back to its 
original value, select UNDO. If you made changes to a several colors in the palette and wish to 
discard all changes and return to the original palette, select CANCEL and the palette will be 
restored to its original condition.

I THE PICTURE MENU

MAIN >■ LINE > -  PICTURE

Standard Amiga "IFF" format pictures may be displayed as background images on any line or 
page. Each line of text may contain an IFF Picture or Brush.

The first step is to load the picture file from disk into resident memory via LOAD PICTURE in 
the File Menu. Refer to the File Menu chapter for instructions on loading pictures from disk.

Select PICTURE from the Line Menu. If there are pictures loaded in resident memory, the 
names of those pictures will appear in the long Picture Name Button. Clicking on this button 
will advance through the pictures available in resident memory.

Once the name of the desired picture appears in the name button, the next step is to place the 
picture on the page by setting both the LEFT and TOP position values. The current position will 
be reflected by the yellow marker in the text display area of the Picture Menu.

To change the position of a previously placed picture, move the Text Edit Cursor to the line 
containing the picture. Select PICTURE to enter the Picture Menu, and alter the setting of the 
LEFT and TOP position values.
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To remove a picture from a line, move the Text Edit Cursor to the line containing the picture. 
Select PICTURE to enter the Picture Menu. Select DELETE to remove the picture from the line. 
The picture will still remain in resident memory, but will no longer be displayed on the page.

A For more a more comprehensive discussion of loading picture files, the use of resident picture 
storage, and automatic picture loading, refer to the LOADING & PLACING IFF PICTURES 
section of the Tutorials chapter.

__ | THE PATTERN MENU _______ _

MAIN LINE PATTERN

A number of background spreads and patterns are built into Broadcast Titler. These patterns use 
Colors 1 through 7 to achieve Cylinders, Stripe Patterns and other background spread effects.

With the Text Edit Cursor on the desired line, select PATTERN from the Line Menu. The words 
"No Pattern" will appear in the Pattern Name Button. Click on this button to advance through 
the names of the available line patterns. Only the pattern name will be displayed. The actual 
pattern will be shown upon returning to the Line Menu.

Set the TOP and BOTtom positions for the pattern by clicking on those buttons, or typing in the 
desired position and pressing RETURN. The new location for the pattern is marked by the white 
indicator lines in the menu’s text window. By adjusting the TOP and BOTtom positions, you 
can create full page patterns.

Set the LEFT and RIGHT pattern edges to other values if you do not want a full-width pattern.

As a convenience, selecting the PALETTE button will bring up the Palette Menu for the purpose 
of quickly selecting or creating a color spread palette for the chosen pattern.
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PATTERN DESCRIPTIONS

No Pattern - The standard setting. Disables the pattern on the current line from the screen.

Vert Spread - Displays a dithered spread of colors from the TOP to the BOTtom position set in 
the menu. With this pattern, it is best that the color values of Color 1 and 7 be fairly close so that 
there is an even color spread.

Cylinder - Creates a horizontal cylinder with Color 2 in the center and Color 7 on the outer edge.

Out Cylinder - Creates a Cylinder with a Black Outline on the top and bottom of the pattern.

Lit Cylinder - Creates a Cylinder with a highlight.

Stripes - Creates horizontal stripes alternating between Color 2 and 7.

Box - Creates a Box with Color 2.

Col 1 BG - Creates a plain pattern with Color 1.
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CHAPTER 8

MAIN ^  PAGE

The Page Menu contains a number of handy functions for editing and rearranging pages in a 
sequence. The following can be accomplished in the Page Menu:

- Access the Page Effect Menu to select page effects, color cycle, and flash effects
- Access the Layout Menu to alter page margins, tabs, and centering
- Copy & Paste Pages
- Insert and Append Pages
- Clear and Delete Pages
- Declare a PRESTO page
- Jump to any page

Although the menu may look intimidating at first, it is actually designed to provide you with a 
birds-eye view of your sequence.
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In the center of the menu is a page information list which includes the page number, the first line 
of text from the page, and the effect for each page.
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FINDING A PAGE IN THE SEQUENCE

You can locate a specific page at a glance by looking at the text lines listed for each page of the 
sequence. If the desired page does not appear in the page list, simply click on the Page Down 
button or press PgDn ("3" on the Numeric Keypad) from the keyboard, artd the next set of ten 
pages will be displayed.

To jump to the end of the sequence, click on the END button or press END ("1" on the numeric 
keypad) from the keyboard. To jump to the first page in the sequence, click on the HOME 
button or press HOME ("7" on the numeric keypad) from the keyboard.

To advance to the previous set of ten pages, click on the PAGE UP button or press PgUp ("9" on 
the numeric keypad) from the keyboard. When the desired page appears in the page list, click on 
the wide page text button to select that page for editing operations.

To edit text on the page, select EDIT to return to the Text Edit Mode with the selected page as 
the current edit page.

To change the Page Effect for the selected page, click on the EFFECT button, or click on the 
effect name that appears on the right side of the menu. The Page Effect Menu appears.

To modify the palette for the selected page, select the PALETTE button, which will enter the 
Palette Menu. To change the page margins, page centering, or tab stops, select the LAYOUT 
button.

To enable the Presto Playback feature for the selected page, select PRESTO. See the Play Menu 
chapter regarding the use of this option.

APPENDING A PAGE TO THE END OF A SEQUENCE

To add a new blank page to the end of a sequence, select APPEND at the bottom of the menu. A 
new page will be created and the page highlight will move to the very bottom of the page list. To 
edit that page, select EDIT and type in the text for the new page.

▲ Appending a new page can also be done in either the Text Edit Mode or the Main Menu by 
pressing SHIFT-PgDn from the keyboard.

INSERTING A NEW PAGE IN THE SEQUENCE

To insert a new blank page above any existing page in the sequence, select the page location in 
the page list at which you wish to insert the new page, then select INSERT. The pages below the 
insertion point will be moved down one position, and the new blank page will be created in the 
location selected. To enter text for this new page, select EDIT.
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DELETING A PAGE

To delete a page from the sequence and place a copy of it into the page copy buffer, click on the 
page you wish to delete in the page list. Then select the DELETE button and the page will be 
deleted from the sequence. All lower pages will be moved up one position in the page list.

This option does not just clear the page, but rather it completely removes the page from the list. 
Before the page is deleted, it is automatically copied into the page copy buffer. If needed, the 
contents of the deleted page can be retrieved by selecting INSERT and then selecting PASTE.

DUPLICATING A PAGE

To make two identical copies of a page, click on the page you wish to duplicate. Then select 
COPY, which copies that page into the page copy buffer. Then select INSERT to insert a new 
blank page at the point you wish to insert the duplicate page. Finally, select PASTE to paste a 
copy of the page onto the blank page just created.

CLEARING TEXT FROM A PAGE

To clear all of the text and color windows from a page, click on the page you wish to clear. Then 
select CLEAR at the bottom of the menu. This will clear the page, with no line height 
definitions or color windows yet defined. It does not actually add a page to the sequence, it 
merely clears an existing page.

A If you wish to clear the ENTIRE sequence, you should use the CLEAR SEQUENCE option in 
File Menu.

REPEATING AN EFFECT OVER SEVERAL PAGES

This function gives the user a quick and easy way of changing effects over successive pages 
without having to repeatedly enter the Effect Menu and change the effect for each page. 
Normally, as you create new pages in the sequence, the effect for the previous page is copied 
onto the new page automatically.

However, suppose you are creating a Roll sequence of ten pages and you have forgotten to set 
the Roll effect before going on to create the second through tenth pages. Your sequence will 
contain ten Cut effects instead of ten Roll effects.

To remedy this, on the right side of the menu select the first Page Effect Name Button in the list 
and the Effect Menu will appear. Set the Effect and Speed to the values you desire, in this case 
"Roll". Click the Right Mouse Button or press ESC to return to the Page Menu.
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At this time, the list will show Page One with a Roll effect, and the remaining pages still have 
Cut as their assigned effects. With the first page still highlighted, click on the REP EFFECT 
button. The Page Menu highlight will advance to the next page and the effect for that page will 
automatically be changed to Roll as well. Continue selecting REP EFFECT until all desired 
pages have the same effect.

SETTING PRESTO PAGES

The PRESTO option is provided to increase the speed at which complex pages are built during 
playback. For a complete explanation of this feature, refer to the USING PRESTO PAGES 
section in the Play Menu Chapter, as well as the ROLLING PRESTO PAGES section in the 
ROLL EFFECT Tutorial, Chapter 3.

SETTING PRESENTATION PLAYBACK PAGE GROUPS

The Page Menu chapter fully describes the operation of the Presentation Mode Playback option. 
To select a specific page as the first page in a Presentation Playback sequence, select the page in 
the list which is to be called up when function key FI is pressed. From the keyboard, press 
function key FI. The function key you have pressed will be indicated to the left of the page list.

The ten function keys F1-F10 can be assigned to any pages in the sequence. During Presentation 
Playback Mode, pressing FI will play from the chosen page.

If you wish to remove a Presentation function key label, simply select the page containing the 
label, and press the indicated function key. The function key label will be removed from the 
page list. See the Play Menu chapter for more information.

I PAGE EFFECT MENU________________________

MAIN PAGE »■  EFFECT

FULL PAGE TRANSITIONS

During playback, each page of a Broadcast Titler sequence can be brought onto the screen in a 
variety of different ways. The Effect Map section later in this chapter gives an overview of some 
of the transitional effects that can be selected to introduce each page. Most of these effects can 
operate at nine different speeds. These full Page Transitions introduce one page of text at a time. 
The Page Effect Menu selects the transition type, and controls its timing and speed.
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SELECTING AN EFFECT

To select an effect for the current page, use the mouse to click on the desired effect name from 
the list at the top of the menu. Or using the keyboard, highlight the numbered effect name box at 
the bottom of the menu, and press the UP Arrow or DOWN Arrow keys to advance through the 
available effect names. To exit the menu click the Right Mouse Button or press ESC from the 
keyboard.

SETTING THE SPEED OF THE EFFECT

Each page effect can be set to execute at nine different playback speeds, with speed 1 being the 
slowest, and speed 9 the fastest. After selecting the desired effect, highlight the SPEED button. 
Click to the left of the speed value to decrease the speed, or to the right of the number to 
increase. From the keyboard, the UP Arrow and Down Arrow keys are used to change the 
SPEED value. In addition, the SPEED value may be typed in directly from the keyboard and 
entered by pressing RETURN.

The Roll Effect is special in that if set to SPEED 1, it will invoke the variable 1,000 speed mode 
for all successive Roll Pages. See the ROLL EFFECT Tutorial in the Chapter 3 for a complete 
example.
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SETTING THE HOLD TIME

After the effect brings the new page onto the screen, it will remain visible, or "HOLD", for the 
amount of time specified in the HOLD button. The HOLD time is represented as 
minutes:seconds:video fields. Minutes and seconds are self explanatory, a value of 2:01.00 
represents two minutes and one second. Fractional seconds are represented in the video fields 
area.

For the NTSC version, the video fields value has a range of 00 to 59. There are 60 NTSC video 
fields in a second. So 0:00.30 is half a second, and 0:00.59 is just one video field shy of a full 
second.

For the PAL version the video fields value has a range of 00 to 49. There are 50 PAL video 
fields in a second. So 0:00.25 is half a second, and 0:00.49 is just one video field shy of a full 
second.

The standard HOLD time is set to 0:02.30 (0:02.25 PAL) or 2.5 seconds. To increase the HOLD 
time, highlight the HOLD button and press and hold the Left Mouse Button to the right of the 
HOLD time, or press the UP Arrow key from the keyboard.

To decrease the HOLD time, highlight the HOLD button and click and hold the Left Mouse 
Button on the left of the HOLD time, or press the DOWN Arrow key from the keyboard.

To enter a new time value directly from the keyboard simply type in the desired time and press 
RETURN. Typing in the time punctuation marks is optional. Entering "12030" and pressing 
RETURN will produce a time of 1:20.30, or one minute, twenty seconds, and 30 video fields.

A When using the dock, DateTime and CountDown effects it is necessary to set the HOLD 
time to indicate how long the clock timer is to keep running before advancing to the next page in 
the sequence.

A If you need to advance to the next page in less than two or three seconds, and find that 
reducing the HOLD time does not bring the next page up soon enough, it is possible that the 
page is too complex to be generated in such a short time. Extensive use of shadows, outlines or 
small fonts can slow down the page building process to the point that several seconds are needed 
to build the next page, causing the last page to remain on screen longer than desired.

In order to speed up page rendering during playback, Broadcast Titler provides a pre-rendered 
PRESTO PAGE playback mode that can dramatically reduce the amount of time needed to draw 
the next page. Refer to the SETTING PRESTO PAGES section earlier in this chapter for further 
details.
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CLEAR OLD PAGE / KEEP OLD PAGE

Normally you will not need to change this option. This button controls what happens to the last 
page when the next page effect begins.

If you wish the previous page to disappear as soon as the next page transition begins, then select 
the CLEAR OLD PAGE option. This is useful in side-to-side transitions when the new page has 
a different color palette than the previous page. Rather than displaying the previous page with 
the wrong color palette (the Amiga can’t switch color palettes horizontally), it is better to blank 
out the old page, switch to the new palette and bring on the new page. The effects that might 
especially benefit from this setting are Left or Right Page Push, Weave, Wave, Sew, and pages 
containing individual Line-by-Line Transitions.

If color palette conflicts are not a problem, and the line heights of the last and current page are 
acceptably aligned, then KEEP OLD PAGE may be chosen to leave the old page visible while 
the current effect transpires. In this way the current page can push off the previous page or text 
lines.

An interesting special application of the KEEP OLD PAGE feature involves the Cut effect. 
Normally the Cut effect uses the CLEAR OLD PAGE option. But if KEEP OLD PAGE is 
selected, the previous page will not be cleared and the new page will type on top of the previous 
page, giving a multi-layered effect.

▲ These features are provided only for the purpose of alleviating color palette and line height 
conflicts for Side to Side moving transitions. Any further application of this feature for any other 
purpose is not supported, and may not give the desired result.

COLOR CYCLING

Color Cycling is a color palette effect that makes images and patterns drawn with Colors 1 
through 7 appear to move in a smooth wave-like manner. Color Cycling is used extensively in 
video weather maps to represent the flow of the Jet Stream moving across the globe.

COLOR CYCLING

Color Cycling works best with a gradient spread of colors in the palette ranging from Color 1 
through Color 7. See the CREATING COLOR PALETTE SPREADS section in the Line/ 
Palette Menu chapter for more details on how to create color spreads.
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The rate at which the Cycled image appears to move is in part determined by the CYCLE speed 
button located at the bottom of the Page Effect Menu. Cycle speed 0 indicates that Cycling is 
turned off. Cycle speed 1 is for slow cycling, Cycle speed 32 is for rapid cycling.

If a Cycle speed of 1 through 32 is selected for a page, all instances of color 1 through color 7 on 
the current page will cycle at the selected rate. The color cycling wotks independently of the 
Page or Line transitions in effect for the page.

▲ Do not use Cycle speeds 33 through 64 for color cycling. These speeds are reserved for the 
FLASHING TEXT feature described below.

FLASHING TEXT

Flashing Text is a.special color palette effect that flashes any text on the page which is drawn 
with color 10. To create Flashing Text, go to the Font Menu and click on the FACE COLOR 
button until "Color 10" is displayed. Type in the text that is to flash while the page is played. 
Type in any non-flashing words using Color 14, Color 2 or Color 6 only.

The best results are obtained if Color 10 and Color 14 are similar colors. Enter the Palette Menu. 
Click on the "FA" Face Color Box ( Color Box 10). Change Color 10 to nearly the same shade 
as Color 14, but make the color a litde darker than Color 14 to make it easier to identify the 
flashing characters separately while editing text.

In the Page Effect Menu select a Cycle speed of 33 for slow flashing to 64 for rapid flashing. A 
Cycle speed of 50 is a good recommended flash rate.

During playback, the text drawn with color 10 will appear to alternate between the shade in 
Color Register 14 and Color Register 0.

PAGE EFFECT DESCRIPTIONS

Build - The current page is created by moving each line in the direction of the arrow in the Effect 
Name Box. Diagonal direction "Builds" specify the order and direction of the text lines. For 
example, diagonal direction "upper right" will move all text lines from the left to the right, 
starting from the bottom of the page.

Cross Wipe - The current page is split into top and bottom halves. The top half is "wiped" from 
left to right. The bottom is "wiped" from right to left. Both halves of the wipe are executed at 
the same time.

Cut - Instantaneously displays the current page with no special effects. Transition speed has no 
affect on this transition.
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Ease - The current page rapidly accelerates toward the direction specified, then gradually 
decreases speed as it gets closer to the center.

Fade Black - All page color values of the previous page gradually decrease to Black 
(Red=0,Green=0,Blue=0). The current page fades in from Black.

Fade Color 0 - All foreground text or graphics gradually change to the shade found in 
background color register 0. The new text fades in from Color 0.

Flip Coin - The previous page "rotates" on it’s horizontal axis, changing to the current page in 
the sequence as it completes it’s rotation.

Flip On - Creates the illusion that the next screen is rotated from a flat horizontal position.

Layer - Reveals the current page with progressive dual-direction line spreads.

Pop - Causes the lines of the current page to appear one line at a time in the direction specified.

Pull - Moves the current page over the previous page in the direction specified.

Push - Moves the current page in one of eight directions while "pushing" the previous page off 
the screen in the same direction.

Random Stripes - Randomly places thin vertical strips of the current page onto the previous page.

Reveal - Moves the previous page in the direction specified while revealing the current page 
underneath.

Roll - "Credit Rolls" one or more pages from the bottom of the screen to the top.

Sequential Wipe - Individually "wipes" each line onto the page starting from either the top or bottom

Sew - Each line eases in one at a time from alternating sides of the screen.

Skip - This effect will completely ignore the current page in the sequence and "skip" to the next 
page. This is most useful for users running 24 hour information displays that need to display 
pages only at certain times.

Spread - The page is wiped onto the screen from the center to the left and right edges of the 
screen (Spread In), or from the edges to the center (Spread Out).

Stripes - Thin vertical slices of the image are layered onto the screen.

Teletype - "Types" each character, one at a time from left to right. The rate of the character 
typing is determined by the transition speed.
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Tumble - The previous page flips away, and the current page is revealed by rotating it on its 
horizontal axis.

Wave - Each line on the current page appears in a wave-like pattern in the direction specified.

Weave - Each line eases in from alternating left and right sides of the screen, creating a weaving 
pattern. Although similar to the "Sew" effect, the delay times in which the lines move are shorter 
than the delay times used in the "Sew" effect.

Wipe - A moving edge appears to cross the page, revealing the new page as it moves.

Zig Zag - Reveals the lines of a page in an alternating right-to-left, then left-to-right pattern 
progressing down the page.

PAGE EFFECT MAP

1 Cut
2 Ron
3 Crawl
4 Teletype
5 PushUp
6 Push Upper Right
7 Push Right
8 Push Lower Right
9 Push Down
10 Push Lower Left
11 Push Left
12 Push Upper Left
13 Ease Up
14 Ease Upper Right
15 Ease Right
16 Ease Lower Right
17 Ease Down
18 Ease Lower Left
19 Ease Left
20 Ease Upper Left
21 Pull Up
22 Pull Down
23 Reveal Up
24 Reveal Down
25 Wave Upper Right
26 Wave Lower Right
27 Wave Lower Left

28 Wave Upper Left
29 Weave
30 Sew
31 Pop Up
32 Pop Down
33 Buildup
34 Build Upper Right
35 Build Lower Right
36 Build Down
37 Build Lower Left
38 Build Upper Left
39 Hip On
40 Flip Coin
41 Tumble 2
42 Tumble 5
43 Layer Up
44 Layer Down
45 Wipe Up
46 Wipe Right
47 Wipe Down
48 Wipe Left
49 Spread In
50 Spread Out
51 Cross Wipe
52 Sequential Wipe Up
53 Sequential Wipe Down
54 Zig Zag

55 Stripes In
56 Random Stripes
57 Spiral In
58 Spiral Out
59 Checker
60 Stack Right
61 Stack Down
62 Paint
63 Falls
64 Random Squares 
65-68 * RESERVED *
69 24 Hour Clock
70 12 Hour Clock
71 Date and Time
72 Countdown Timer
73 Fade Black
74 Fade to Background
75 Sail
76-89 SUPER HIGH-RES 

EFFECTS
90 Blank and Dissolve In
91 Dissolve Fast/Slow
92 Dissolve Med/Med
93 Dissolve Slow/Fast
94 Dissolve Background In
95 Dissolve Background Out
96 Skip Over This Page
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THE PAGE PALETTE MENU
MAIN *■ PAGE » -  PALETTE

The Page Palette Menu is identical to the Line Palette Menu. The only difference is that it is 
more convenient to alter the palettes of multiple pages within the Page Palette Menu than the 
Line Palette Menu. For complete descriptions of the Palette Menu, refer the Line Palette Menu 
section, located in the Line Menu chapter.

THE LAYOUT MENU

MAIN PAGE > - LAYOUT

The Layout Menu lets the user change the formatting of any page within a sequence, giving the 
user control over page centering, text margins, tab stops, the position of the Crawl line effect, as 
well as vertical cropping for the Roll effect.

PAGE CENTERING OPTIONS

While the Text Edit mode allows independent centering of any text line via CTRL "L" (left 
justify), CTRL "C" (center justify), CTRL "R" (right justify), the Layout Menu will center all of 
the lines on the page all at once. Select the LEFT, CENTER, or RIGHT option in the Layout 
Menu and the page will be redrawn with the new centering option in effect for all lines on the 
page.

To adjust the centering of additional pages, select PAGE UP or PAGE DOWN from the menu, or 
press PAGE UP or PAGE DOWN from the keyboard.
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SETTING THE PAGE MARGINS

The top, left, right and bottom text margins are represented in the upper portion of the Layout 
Menu by a box outlining the text on the page. Text can only be typed within the area bounded by 
these margin settings. The margins are designed to keep the text typed on the page within the 
"Safe Titling Area" which represents the central 80% of the screen that is always visible even on 
severely overscanning television sets and monitors. Text typed outside this area may not be 
visible on all televisions, so it is important to keep this in mind if you are going to change the 
margin settings in Broadcast Titler.

To change the setting of any of the margin values, highlight the appropriate margin button. Click 
to the left of the number to decrease the margin position value, or click to the right to increase 
the value. The margin indicator line will move to the new location for the correct margin setting. 
The number can be changed rapidly by pressing and holding the mouse button, and the number 
will continue to change in the direction you have chosen. In addition, with the margin button 
highlighted, the number may be increased or decreased by pressing the UP or DOWN Arrow key 
from the keyboard. Direct type in entry of the value is accomplished by highlighting die margin 
button, typing in the new value, and then pressing RETURN.

▲ When the Bottom Margin button is highlighted, the page display area of the Layout Menu will 
be shifted upwards so that the Bottom Margin indicator can be seen.

REPOSITIONING THE PAGE

All lines of text on the page are positioned relative to the placement of the Top Margin. By 
raising the Top Margin for the page, all lines of text for that page will be shifted up by the same 
distance. Similarly, lowering the Top Margin will shift all lines of text down by the same 
distance.

SQUEEZING IN EXTRA TEXT LINES

If you should need to add one more line of text to the page, but the current margin setting won’t 
let you type at the bottom of the page, then adjusting the Top and Bottom Margins will give you 
a little more room to work with. Start by moving the Top Margin up by about ten scanlines, and 
lowering the bottom margin by about sixteen scanlines.

A If you have changed the top margin on a page that already contains lines of text, you may 
need to change the color window line heights for each line if you are going to use line transitions 
for the page. See the Palette Menu chapter for more information on changing color window 
heights.
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SQUEEZING IN EXTRA CHARACTERS ON A LINE

If you wish to add more characters to a line of text than can fit between the Left and Right 
Margins, simply decrease the Left Margin value by about twenty pixels and increase the Right 
Margin value by the same amount.

Be certain to leave enough blank space on the far left and right of the page to keep the text within 
a reasonable Safe Titling Area.

Alternatively, additional characters may be squeezed into individual lines by pressing SHIFT and 
LEFT Arrow while in the Text Edit mode. This squeezes all of the characters on a line together 
by a small amount, which frees-up additional space at the end of the line. You can then type in a 
few additional characters without changing the margin settings or sacrificing the Safe Titling 
Area. See the Text Edit Mode chapter for more details.

MARGIN SETTINGS FOR SUBTITLING

Subtitles are commonly used in films or documentaries to caption foreign language translations 
in a few lines at the bottom of the page. Broadcast Tider normally will place the first line of text 
for a page at the top of the screen. For subtiding applications, it is helpful to have the text entry 
cursor and the first line of text appear at the bottom of the page where the subtiding captions are 
to be placed. This saves the user from having to enter a number of blank lines before reaching 
the bottom of the page.

This also is helpful when using the ASCII LOAD function for entering subtides. For example, if 
exacdy two lines are alloted for each caption, then an ASCII file can be created with just two 
lines per caption. For short captions, this could be one line of text and a second blank line. Each 
Broadcast Tider page will then be filled with exacdy two lines of text, and then the next caption 
page will be filled in, and so on.

To achieve this setup, simply set the Top Margin to about 40 to 80 scanlines above the Bottom 
Margin. This will depend in part upon the size of the font which you will be using. Create the 
subtiding pages, and for each new page created, the same margin settings will automatically be 
used for the new page.

SETTING TAB STOPS

There are five user definable Tab Stop positions available for each page of text. Tab Stops are 
handy for creating even columns of text for annotating charts, diagrams and creating columned 
tables. Pressing the TAB key, located above the CAPS LOCK key on the keyboard, will 
advance the Text Edit Cursor to the next Tab Stop position. Each additional Tab key pressed 
will advance to the next of the five available Tab Stops.
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The standard Tab Stop settings can be changed in the Layout Menu by clicking to the left or right 
of the Tab Stop number to change its location. The five vertical dotted lines represent the 
positions of the five Tab Stops for the current page. Each time the Tab Stop position is changed, 
the corresponding Tab Stop indicator is moved to the new position. To enter the values directly, 
simply highlight the button, type in the numeric value from the keyboard and press RETURN.

POSITIONING THE CRAWL EFFECT LINE

The Crawl Effect scrolls a single long line of text from right to left across the page. The crawl line 
can be placed vertically anywhere on the page, allowing the crawl to occur across the top, middle, or 
bottom of the page. The top scanline on which the top of the crawl message is to occur is controlled 
by the Crawl Line button. To change the position of the Crawl Line, click to the left or right of the 
numeric value, or enter a scanline value from the keyboard and press RETURN. The Crawl Line is 
represented as a solid white line on the page. When moving the Crawl Line to the bottom half of the 
screen, the page display area will shift upward for proper viewing.

A  See the Crawl Effect Section in the Tutorials chapter for a complete example.

CHANGING THE ROLL CROP MARGINS

In order to prevent unwanted gaps between pages in a Roll Effect, it is necessary to display only 
the areas of each page actually containing text. To do this, a special top and bottom Roll Crop 
indicator is provided to cut away the top and bottom overscan areas from each page. Only the 
scanlines contained between the Top and Bottom Roll Crop Margins will be included in the 
Roll. These controls give precise adjustments so that multiple pages of evenly spaced text can be 
Rolled without any seams appearing between pages.

A See the Roll Effect section of the Tutorials chapter for more information.
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I  CHAPTER 9
□ TOE P LM  MEMU

MAIN >► PLAY

The Play Menu provides the following options for playing back a sequence in a variety of ways:.

- Single Play, Continuous Loop, Random Access and Keywait Advance playback modes. 
The playback can start from any page in the sequence.

- Playback can begin immediately for quick rehearsals, or it can be initiated via the 
Keyboard, a Mouse Click, or through a GPI contact closure.

- The Presto Page rendering option will pre-render a series of pages to speed up the 
playback of complex pages.

- The Screen Options Menu gives access to Video Centering controls, and sets the Status 
Bar Position for Random Access Playback.

■ n s
F fi

The following four playback options can be invoked by pressing the corresponding keyboard 
function key (FI through F4) in either the Main Menu, the Text Edit Mode or in the Play Menu.

FI - PLAYING FROM THE CURRENT PAGE

To begin playing the sequence from the current page, select PLAY CURRENT or press FI from 
the keyboard. This serves as a quick playback rehearsal for the effects governing the current and 
successive pages.

The "Current page" is the page last edited in the Main Menu or the Page Menu. To change the 
current page without having to leave the Play Menu, highlight the PAGE button to the right of 
the PLAY CURRENT button. Click to the left of the page number to decrease. Click to the
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right of the page number to increase. Or enter the desired starting page via the keyboard, and 
press RETURN. Press FI to initiate the effects playback from the specified page.

To terminate the playback at any time before reaching the end of the sequence, press ESC from 
the keyboard.

If very rapid access to pages is needed, page drawing time may be reduced for complex pages if 
the Presto Page option is used. The Presto option is described later in this chapter.

F2 - PLAYING FROM PAGE ONE IN THE SEQUENCE

To begin playing from page one in the sequence, press F2. To terminate the playback at any 
time before reaching the end of the sequence, press ESC from the keyboard.

Used in conjunction with the GPI Start option described below, this function is ideal for final 
playback of the sequence for recording to video tape. The GPI Start causes the program to wait 
for any keypress, left mouse button click or a GPI contact closure to start playing at a precise 
time.

If very rapid access to pages is needed, page drawing time may be reduced for complex pages if 
the Presto Page option is used.

F3 - RANDOM PAGE PLAYBACK

The Random Access Playback Mode lets the user play pages in any order by typing the page 
number of the next desired page. If the Status Bar option has been activated from the SCREEN 
OPTIONS Menu, then the page number and the first line of text from the page will be displayed 
at the bottom of your RGB monitor for verification.

▲ If the sequence contains 99 or fewer pages, page numbers should be typed as two digits. For 
example, type "02" for page two. If the sequence contains 100 or more pages, enter all page 
numbers as three digit values. For example type "002" for page two, "010" for page ten, etc.

The page is now drawn and is ready for display. When ready, press RETURN to initiate the 
effect for the page, or type in a new page number if you do not wish to show this page after all.
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Other keyboard playback commands available:

HOME
END
PAGE UP 
PAGE DOWN 
SPACE BAR 
LEFT MOUSE 
BACK SPACE 
ESC 
F1-F10

- Go to page 1 in the sequence
- Go to the last page of the sequence
- Go to previous page
- Advance to next page
- Advance to next page
- Advance to next page
- Cancels page number currently being typed
- Terminate playback and return to the Play Menu
- Calls up a series of Presentation Playback pages

If rapid access to pages is needed, page drawing time may be reduced for complex pages if the 
Presto Page option is used. If the pages are to be accessed sequentially, page access time is also 
improved by using the F4 PLAY KEYWATT option.

F4 - WAIT FOR KEYPRESS BEFORE EACH PAGE

The Wait For Keypress Playback Mode lets the user step through pages in a linear order, waiting 
for a mouse click or SPACE BAR keypress before advancing to the next effect.

After pressing F4 or selecting PLAY KEYWAIT, the screen will display a blank page. Press the 
SPACE BAR to bring up the first page. The first page played will be the page selected in the 
PAGE button in the Play Menu.

Other keyboard playback commands available:

HOME
END
PAGE UP 
PAGE DOWN 
SPACE BAR 
LEFT MOUSE 
ESC 
F1-F10

- Go to page 1 in the sequence
- Go to the last page of the sequence
- Go to previous page
- Advance to next page
- Advance to next page
- Advance to next page
- Terminate playback and return to the Play Menu
- Calls up a series of Presentation Playback pages

If rapid access to pages is needed, page drawing time may be reduced for complex pages if the 
Presto Page option is used.
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PRESENTATION PLAYBACK MODE

The presentation Playback Mode works in conjunction with the F3 - Random Access and the F4- 
Play Keywait playback modes. It allows keyboard function keys FI through F10 to call up a 
subset of pages from the sequence. This segmented playback ability has many useful 
applications for live presentations.

Example:

This example assumes that you have ten or more pages in your sequence. Go to the Page Menu. 
Select Page 1 in the page list. Press function key FI once. You will see a white "FI" indicator to 
the left of Page 1 in the list, indicating this page is to be accessed by function key FI.

Select Page 5 in the page list. Press function key F2 once. The white "F2" indicator marks Page 
5 as the page accessed by function key F2.

Function key FI will serve to play Pages 1 through 4 on command. Function key F2 will play 
from Page 5 through the last page of the sequence.

Enter the Play Menu. Select PLAY KEYWAIT, or press F4 from the keyboard. The initial 
blank screen appears. When ready, press function key FI. Pages 1 through 4 will appear in order 
with the transitions and hold times assigned to those pages. The playback will hold on Page 4 
until you press another key since the next page (Page 5) is assigned to a different function key.

Press F2. The playback will resume with Page S, and will continue until the last page of the 
sequence is reached. The last page will be held on screen until another function key is pressed, 
or until the ESC key is pressed to terminate the playback.

The ten function keys can be assigned to any page, and in any order you choose. To remove a 
function key assignment, select the indicated page in the Page Menu, and press the function key 
listed for that page. The function key label will be removed from the list.

GPI START PLAYBACK

The sequence playback can be initiated by a GPI trigger (General Purpose Interface) or 
contact closure through mouse port 2 on the Amiga. The actual signal line corresponds to the 
Left Mouse Button pin of the second mouse port.

To use this feature, select the GPI START button so that it says "GPI START ON". Then 
select one of the playback modes outlined above. The program will play when a GPI 
trigger pulse is received, or when the Mouse Button is clicked (either mouse port).
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LOOP PLAYBACK MODE

The effects playback can be set to repeat over again after playing the last page of the sequence. 
To activate Loop Playback, select the LOOP MODE button so that it displays "LOOP MODE 
ON", or from the keyboard press F5. Then select one of the above play options to run the 
sequence of effects.

VIEW PAGE/ HIDING THE CURSOR

Sometimes it is desirable to view a selected page and hold it on screen while hiding all cursors. 
This option is useful for photographing the screen, making slides, and for composing pages. To 
do this, go to the Text Edit Mode. Move to the desired page. Press F5, and the cursors will 
disappear. When ready, press any key to bring back the cursors.

USING PRESTO PAGES

Presto Pages are pie-drawn pages that can be generated and displayed very quickly during 
playback. Complex pages having heavy shadows or densely populated with text may require up 
to several seconds to generate, which may delay the appearance of the page even beyond the 
assigned Hold time.

Even though Broadcast Titler utilizes the best performance available from the Amiga’s hardware, the 
high resolution overscan display used by Broadcast Titler, along with the processing demands of 
sharp, four-level anti-aliased characters, limits the speed at which complex pages can be generated.

Effects such as Roll may require rapid generation of pages to prevent gaps from appearing 
between successive pages. If the next page of a Roll cannot be generated in time, there may be a 
series of blank scanlines inserted before the next page. Using Presto Pages for selected pages that 
need to be generated in a hurry will help to eliminate this problem.

To set the Presto option for a page, enter the Page Menu. Select the page you wish to make a 
Presto Page. Select the PRESTO button from the menu. A "P" will appear to indicate that page 
is set for Presto playback. In the Play Menu, set the first page to be played in the PAGE button. 
Then select DRAW PRESTO PAGES. The message DRAWING PAGE # will appear, and will 
indicate the amount of Presto Page memory available. As many pages as will fit in available 
memory will be rendered.

A If the message "NO PRESTO PAGES" appears, check to see that the PAGE number button is 
set to the first page you wish to play, usually Page 1. Also verify that the Presto option has been 
set for the desired pages in die Page Menu.

When the Presto Page pre-rendering operation is complete, select the playback option you wish 
to use (F1-F4). The selected pages should be generated more quickly than before, allowing 
virtually uninterrupted playback regardless of page complexity.
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▲ Be aware that the Presto Page feature is intended for pages composed primarily of Text. If the 
page contains large IFF brushes or large dithered background patterns, the Presto Page feature 
may not always display the page properly. Use Presto Pages primarily for text pages.

If you return to the Text Edit Mode you will need to select DRAW PRESTO PAGES again 
before playing the sequence another time. Rendered Presto Pages are not saved with the 
sequence. They are generated only by selecting DRAW PRESTO PAGES in the Play Menu.

THE SCREEN OPTIONS MENU
MAIN »- PLAY *■ SCREEN OPTIONS

The Screen Options Menu is provided to customize the Amiga’s display to provide control over 
the video screen position, and the operation and placement of the Status Bar for random access 
playback.

To compensate for the horizontal screen delays introduced by some genlock devices, the Screen 
Position control allows the screen to be shifted left or right to one of four positions. Although 
the graphics display on the Amiga RGB monitor may appear centered, once the video is viewed 
through a genlock on your edit monitor, the entire screen may appear to be shifted to the right.

To compensate for this shift, which may be more severe depending on the make of your genlock, 
select screen positions 1,2,3 or 4 to shift the screen to the left or right so that the image appears 
centered on your NTSC monitor.

To aid in centering the text on the page, the current left and right text margins, which represent 
the Safe Titling Area, are outlined on the upper portion of the menu. Center these indicators so 
they are spaced evenly between the extreme left and right horizontal blanking. This is best 
accomplished using the Underscan Switch of your monitor, or by using an overscan monitor that 
has been accurately centered with respect to horizontal blanking.
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ACTIVATING THE STATUS BAR FOR RANDOM ACCESS PLAYBACK

The Status Bar is a special on-screen message area designed to cue the operator with status 
information during the Random Access Playback Mode. The Status Bar allows the operator to 
actually see the page number being typed for the next page. It also informs the operator that the 
page has been generated and is ready for display. The Status Bar also displays the first line of 
text from the page to verify that this is the correct page. Pressing RETURN, the SPACE BAR, 
or the Left Mouse Button triggers the effect for the new page.

To activate the status bar, click on the STATUS BAR button and choose either the HIGH, 
MEDIUM or LOW position for the Status Bar. On the HIGH setting, the Status Bar will appear 
about forty scanlines from the bottom of the screen so that the bar can be seen on an overscan 
monitor. On the MEDIUM setting, the Status Bar appears approximately 16 lines above the 
bottom of the screen. On the LOW setting, the status bar appears in the last eight scanlines of the 
display.

For the low and medium settings, it may be necessary to use the Underscan switch setting on 
your monitor, or you may need to adjust the vertical height setting which is an available 
adjustment on most monitors, to allow the entire 480 line display area to be seen on the monitor.

The Status Bar operates such that the status information is only visible on the RGB monitor, and 
is not displayed on the genlock output channel. The operator can see what pages are being 
accessed via the RGB Monitor, without having this information displayed on the live channel.

▲ To use this feature, it is important that the genlock is receiving either an incoming video 
signal or Blackburst.

85



I
□

CHAPTER 10
TOE FOLE MEMU
MAIN > - FILE

The Broadcast Titler File Menu handles disk storage and retrieval operations for the various file 
formats used in Broadcast Titler. These include:

- Loading/Saving/Appending Sequence files (.BTS)
- Loading/Saving/IFF Picture files
- Loading Font files (.BTF)
- Loading ASCII Text files.

ip- e n d ”
S A U E  S E Q U E N C E

S E Q U E N C E !

L O A  X> P I C T U R E  1 S  A U E  P I C T U R E

L O A  I> A S C I  I

▲ Before working with Broadcast Titler you should have a formatted floppy disk on hand to 
store your sequence.

LOADING A SEQUENCE

To load a new sequence into Broadcast Titler select FILE from the Main Menu. If you are going 
to load the sequence from a floppy disk, place the disk containing the sequence file in the floppy 
drive now.

Select LOAD SEQUENCE. The disk drive light will go on and in a moment the Disk Menu will 
appear. It will list all of the Broadcast Titler Sequence (.BTS) files found on the Root Directory 
of the disk.

If the file you are seeking is not on the list, type in the name of another disk drive or disk path 
containing your sequence file.

Once the filename appears in the Disk Directory List, use the mouse or keyboard to highlight and 
select the file from the list.
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▲ In order for the sequence to load properly, all auxiliary files used by the sequence must also 
be in the same directory as the sequence (.BTS) file.

These files include:
- the Broadcast Titler Sequence file (.BTS)
- the Picture List file (.PICS)
- the actual IFF Picture files which are listed in the .PICS file.
- the Font List file (.LOAD)

For additional information about these specific file types, refer to the following sections which 
cover these file formats in detail.

USING THE DISK DIRECTORY MENU

When loading and saving files through the File Menu you will be prompted to select the disk 
drive and path name for your files via the Disk Directory Menu.

CANCEL.

A. SELECTING A DISK STORAGE DEVICE

The available disk storage devices on your system are listed in the DEVICE buttons on the left 
side of the menu. To list the files that are on one of these disk drives, simply select the button for
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the disk you wish to use. From the keyboard just type the name of the disk drive, followed by a 
colon character and press RETURN, i.e. type DFO: and press RETURN.

▲ Any time you place a new floppy disk in the disk drive while in this menu, you will need to 
select the DEVICE button for that disk in order to see the list of files on the new disk.

B. SELECTING A DIRECTORY PATH

Directory names in the DIRECTORY list are preceded by the prefix (Dir). To list the files 
contained in a directory on the current disk, select the DIRECTORY button containing the 
directory name that contains the file name.

Or from the keyboard, type in the directory path name and press RETURN, i.e. type 
FHl:BTitler2 and press RETURN to access the BTitler2 directory on hard disk FH1. To access 
a directory within a directory, or what is called a subdirectory, one would enter a path such as 
this: FHl:VIDEO/BTitler2. BTitler2 is a subdirectory, which is contained in the VIDEO 
directory, on hard disk FH1:.

C. SELECTING A FILE TO LOAD OR SAVE

Once the file name appears in the DIRECTORY list, select the file name in the DIRECTORY list 
to load or save that file. To save a file under a new name, type in the file name from the 
keyboard and press RETURN.

D. RETURNING TO THE PREVIOUS DIRECTORY

To list the files from a Parent Directory while you are in a subdirectory, select the PARENT 
button. The path name for the parent directory will be displayed in the DISK PATH bar on the 
bottom of the menu.

A fast way to return to the Root or main directory of the disk is to select the disk drive name 
from the DEVICE list.

E. MONITORING REMAINING RESIDENT STORAGE SPACE

Additional Fonts and IFF Pictures that are loaded into Broadcast Titler are stored in a large Fast 
RAM buffer. Additional Fast Memory (or main computer memory) installed in a system 
provides extended Resident Storage for extra Fonts and IFF Pictures.

The amount of memory available for storing Fonts and Pictures in main computer memory is 
indicated in a memory status line at the top of the Disk Menu. The Message, "520 KB Font 
Storage Remaining", indicates that there are approximately 520,000 bytes of unused main 
computer memory that can be used to store additional Fonts and Pictures.
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▲ If the amount of memory available drops much below "30 KB", you should not try to load 
additional files. To start with a fresh set of Fonts and Pictures, you can select CLEAR 
SEQUENCE in the File Menu, and respond by typing "Y" at the "RELOAD FONTS?" prompt. 
This will release all of the Resident Font Storage, purging the existing set of fonts so that a new 
set can be loaded. After doing this, one should immediately load new fonts by selecting LOAD 
FONT.

F. MONITORING REMAINING DISK STORAGE SPACE

Saving data files requires that enough unused disk space is available that the files will fit on the 
disk without completely filling it up. This is an important consideration for floppy disk users. It 
is best to use a fresh disk for storing sequences if the current disk is more than about 75% full. 
During file Save operations, the amount of free space on the disk is displayed at the top of the 
menu, along with the percentage of the disk capacity that has already been used. If less than 
200,000 bytes of disk space is remaining, or the disk is more than 75% full, then it may be 
advisable to store new files on a fresh disk.

This is most important to keep in mind when working with large sequences. Saving a new 200 
page sequence will occupy approximately 200,000 bytes of unused disk space. A 100 page 
sequence requires about 100,000 bytes, and a 50 page sequence requires about 50,000 bytes.

G. DISK DIRECTORY MENU TIPS

A Always save your work often. It is good a practice to save your work every 30 minutes or so 
to prevent losing perhaps several hours of creative work in the event of an inadvertent hardware, 
software or power failure.

A Always keep extra formatted disks available for saving sequences and fonts. Disks can 
become full if you are saving several sequences on the same disk, or if you save sequences on 
old disks which have not been cleared of old data.

A If the Disk Directory Menu should go blank for an extended period, or if it should become 
inoperative, a disk system error may have occurred. To recover, simultaneously press both the 
LEFT Amiga key and the "b" key. Do this at least twice or until the menu reappears.

SAVING A SEQUENCE

Before you begin, be sure there is plenty of free storage remaining on the disk you are using. In 
general it is best to store your sequences on newly formatted disks. (You should not try to save 
sequences onto the Broadcast Titler Program Disk.)

Select SAVE SEQUENCE to store all of the text pages and effects for the current sequence on a 
disk. When the Disk Directory Menu appears, select the disk drive that you will be using.
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If necessary, select the directory and subdirectory in which the file is to be saved.

When the red DISK PATH bar contains the proper device and path name, type in the file name 
you wish to use for the sequence. For example if you wish to save the sequence in the Root 
Directory on drive DFO:, you would see "DFO:" displayed in the DISK PATH bar.

Example:

To save a file called "MySequence", you would type in the name so that the DISK PATH bar 
contains the file name "DFO:MySequence", and press RETURN.

If saving to a directory or subdirectory, the file name must be preceded by a "/” character, which 
is the key found next to the LEFT SHIFT key on the keyboard. For example if you wish to save 
the sequence in the BTitler2 Directory on drive FH1:, you would see "FH1:" displayed in the 
DISK PATH bar.

To save a file called "MySequence", you would type in the name so that the DISK PATH bar 
contains the file name "FHl:BTitler2/MySequence", and press RETURN. Again, note the Slash 
character separating "BTitler2" and "MySequence".

A. THE SEQUENCE ".BTS" FILE

The SAVE SEQUENCE function will create a Sequence File containing all of the Text Pages, 
Palettes, Patterns and Effects for the current sequence. This information is saved in a ".BTS", or 
Broadcast Titler Sequence file, i.e. "MySequence.BTS". This Sequence File can only be 
changed by loading it into Broadcast Titler. It cannot be modified by using a text editing 
program.

B. THE FONT LIST '’.LOAD” FILE

SAVE SEQUENCE also creates an editable ASCII text file containing the names of all Fonts 
that were in Resident Storage when the sequence was last saved. This information is stored in a 
".LOAD" file, i.e. "MySequence.LOAD". Therefore the file "MySequence.LOAD" contains all 
of the default font names resident when Broadcast Titler was started, plus all additional fonts 
loaded via the LOAD FONT option in the File Menu.

When you next load the sequence "MySequence.BTS", the font list "MySequence.LOAD" will 
automatically be loaded into Broadcast Titler. If the font files in this list match the same fonts 
that are already present in Broadcast Titler, then no additional fonts will be loaded. However, if 
the font files in the list differ in name or ordering from the fonts currently loaded, then Broadcast 
Titler will Clear all existing fonts from Resident Storage and then reload the font files listed in 
the "MySequence.LOAD" file.

An example of this file type is the special purpose file named "BTFONTS.LOAD", which can be
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found on the Broadcast Titler Program Disk. This is a special reserved file name that Broadcast 
Titler looks for and automatically reads when the program first starts. This file contains the 
names of all fonts that are to be loaded as default fonts when the program begins.

The BTFONTS.LOAD file provided with the program looks like the following when viewed in a 
text editing package:

Swiss_50.btf
Swiss_67.btf
Swiss_37.btf
Swiss_25.btf
Swiss_15.btf
Minerva_67.btf
Minerva_50.btf
Minerva_37.btf
Minerva_25.btf
Minerva_15.btf
Sports_80.btf
Sports_40.btf
Spoits_20.btf
Holiday_35.btf
Holiday_25.btf
Holiday_20.btf
Swiss_100.btf

These fonts are loaded into Broadcast Titler in the order in which they appear. The first font in 
the list is used as the default edit font when you first start typing in Broadcast Titler.

All ".LOAD" files may be viewed or changed by using a word processor such as ED. See 
Appendix A - Using ED the System Text Editor for details on editing ASCII text files.

Each file name in the list must be on a separate line and must end in a ".BTF" extension. If you 
are deleting a name from the list you must completely delete that line in the list. There should be 
no blank lines in the list.

C. THE PICTURE LIST ".PICS" FILE

SAVE SEQUENCE also creates an editable ASCII text file containing the names of all IFF Pictures 
and Brushes that were in Resident Storage when die sequence was last saved. This information is 
saved in a "PICS" file, i.e. "MySequencePICS". The file "MySequencePICS" contains the file 
names of all IFF Pictures loaded via the LOAD PICTURE option in the File Menu.

When you next load the sequence "MySequence.BTS", the picture list "MySequencePICS" will 
automatically be loaded into Broadcast Titler. Broadcast Titler will then load all of the pictures 
listed in the ".PICS" file into Resident Storage.
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A It is imperative that all IFF Picture files used in a sequence are copied to the same disk and 
directory that contains the sequence (.BTS) file.

All ".PICS" files may be viewed or changed by using a word processor such as ED. See 
Appendix A - Using ED the System Text Editor for details on editing ASCII text files.

Each file name in the list must be on a separate line. If you are deleting a file name from the list 
you must completely delete that line in the list. There should be no blank lines in the list.

APPENDING A SEQUENCE

To tack an existing sequence to the end of the current sequence being edited, select APPEND 
SEQUENCE. The disk drive light will turn on and in a moment the Disk Menu will appear, 
listing all of the Broadcast Titler Sequence (.BTS) files found on the Root Directory of the disk.

If the file you are seeking is not on the list, type in the name of another disk drive or disk path 
containing your sequence file.

Once the filename appears in the Disk Directory List, use the mouse or keyboard to highlight and 
select the file from the list.

A This feature works best if the individual font .LOAD files for the two sequences contain the 
same fonts and if the fonts are listed in the same order in both files.

CLEARING THE CURRENT SEQUENCE

To erase all pages in the current sequence and start a new, completely empty sequence, select 
CLEAR SEQUENCE. Type a "Y" from the keyboard in response to the "Are You Sure?" 
prompt. Or type "N" to cancel.

If you wish to keep on using the same set of resident fonts for the new sequence type "N" to the 
"Reload Fonts?" prompt. If you wish to clear out all of the current resident fonts to load in 
entirely new ones, type "Y".

A Remember to save your current sequence before clearing it. Once a sequence is cleared, it 
cannot be recovered unless it has already been saved onto a disk.

LOADING AN IFF PICTURE

To load a picture into Broadcast Titler’s Resident Storage for display as a page or line 
background, select LOAD PICTURE. For a more detailed discussion on loading and displaying 
IFF pictures, refer to the Tutorials chapter.
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A It is very important to place a copy of the IFF picture file used in the sequence onto the same 
disk and Directory that contains the sequence (.BTS) file. If this is not done, the picture will not 
be available and will not be displayed the next time the sequence is loaded.

SAVING A PAGE AS AN IFF PICTURE

To save any Broadcast Titter page as an IFF Format Picture File, go to the Main Menu. Jump to 
the page you wish to save as an IFF Picture. Select FILE, and the chosen page will be now be 
displayed at the top of the menu.

Select SAVE PICTURE. The Disk Directory Menu appears. Select the Device, and Directory on 
which to save the picture. Type in the name under which to save the picture, and press RETURN. 
The screen will go blank for a few seconds, and the picture will be saved to disk. The picture file 
will automatically be saved with a ".PIX" file name extension for easy identification.

A Since the Amiga’s standard IFF picture format does not recognize more than 16 colors in 
high resolution, only the topmost palette of 16 colors on the page will be saved with the 
sequence. The character anti-aliasing is not preserved in the IFF picture.

LOADING EXTRA FONTS

To load additional fonts into Broadcast Titter’s Resident Font Storage, place the disk containing 
the Broadcast Titter Fonts (.BTF files) in a disk drive. Select LOAD FONT. The Disk Directory 
Menu appears. Select the Device and Directory which contains the fonts. Select one or more 
font files to load. Click the Right Mouse Button or press ESC when done to exit the menu.

Remember to check the FONT STORAGE REMAINING indicator at the top of the Disk 
Directory Menu to gauge the number of additional fonts that can be loaded based on the system’s 
available memory.

A Only fonts converted by the Broadcast Titter Font Converter, or the optional Broadcast Titter 
Font Enhancer, or the ready-to-go fonts from the optional Broadcast Titter Font Packs may be 
loaded into Broadcast Titter. Amiga Fonts and Color Fonts must first be converted by one of 
these programs before Broadcast Titter can use them. For further information on converting and 
using Amiga and Color Fonts in Broadcast Titter, refer to APPENDIX B: THE FONT 
CONVERTER.

LOADING TEXT FROM ASCII FILES

Text contained in ASCII format files may be loaded into Broadcast Titter. Such files are commonly 
produced in word processing programs. The file must be saved in the ASCII format rather than any 
other format provided by the editor. Text files produced with the Amiga’s System Text Editor, ED, 
are automatically saved as ASCII files, and can be loaded directly into Broadcast Titter.
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In the Text Edit Mode, move the Text Edit Cursor to the line and page in the sequence where the 
ASCH text is to be inserted. Select the Font, Size, Shadow and Colors to be used for the inserted 
text.

Select FILE from the Main Menu. Place the ASCII text file in one of the disk drives. Select 
LOAD ASCH. The Disk Directory Menu appears. Select the Device and Directory which 
contains the text file. Select the text file from the Directory. Each line of text from the ASCII 
file will be loaded into the Broadcast Tider Sequence. It may take up to a minute or more to 
complete the loading operation if the tile contains more than about 400 lines of text.

▲ As of this release, the ASCII LOAD function will load text on a line-by-line basis, and does 
not do a word-wrap split of long lines. If there is a RETURN, or End-of-Line character 
encountered at the end of an ASCII text line, Broadcast Tider will start a new line in the 
sequence. Therefore it is important to keep the ASCII text lines short enough that they can be 
typed in a single line in Broadcast Tider with the cunendy selected font size.
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This appendix gives specific examples of using the system text editor ED to view or change text 
files significant to Broadcast Titler’s operation. The following topics are covered:

- Editing The BTFONTS .LOAD File
- ED Commands
- Editing The Startup-Sequence File

1. EDITING THE BTFONTS.LOAD FILE

This example demonstrates an easy way to change the contents of the BTFONTS .LOAD file 
using ED. The system text editor, ED, is included in the Broadcast Titler Program Disk. ED can 
also be found on the Amiga Workbench Disk provided with every Amiga system.

Although this tutorial modifies the BTFONTS .LOAD file, the example applies to editing any 
other .LOAD file as well. Recall from the File Menu chapter that each sequence is saved with its 
own font list .LOAD as well. The ability to add or substitute fonts in these lists can be a valuable 
feature for advanced users.

Floppy Disk Users

Floppy disk users should boot with the Broadcast Titler Program Disk in floppy drive DFO. Then 
place the disk containing the BTFONTS.LOAD file to be edited in drive DF1.

From the Broadcast Titler Autoboot Menu, type in the following command:

ED DFl:BTFONTS.LOAD and then press RETURN.

Hard Disk Users

Hard disk users most often will have Broadcast Titler and the BTFONTS.LOAD file located in 
the BTitler2 directory created by the hard disk installation procedure outlined in Chapter 2. This 
example assumes that hard disk partition containing Broadcast Titler is FH1.

From the Workbench CLI, type the following command:

ED FHl:BTitler2/BTFONTS.LOAD and then press RETURN.
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Editing The File

The editor will load the designated ASCII text file and will display it on screen. The standard 
BTFONTS.LOAD file provided with the program should contain the following list of file names:

Swiss_50.BTF
Swiss_67.BTF
Swiss_37.BTF
Swiss_25.BTF
Swiss_15.BTF
Minerva_67 .BTF
Minerva_50.BTF
Minerva_37.BTF
Minerva_25 .BTF
Minerva_l 5 .BTF
Sports_80.BTF
Sports_40.BTF
Sports_20.BTF
Holiday_35.BTF
Holiday_25 .BTF
Holiday_20.BTF
Swiss_100.BTF

▲ Refer to the File Menu chapter for further information concerning the uses and proper format 
for the .LOAD file.

A tinted rectangular edit cursor will appear in the upper left comer of the file. To move this 
cursor to the bottom of the list, press the DOWN Arrow key from the keyboard several times.

To insert a blank line at the cursor position, press RETURN. A new blank line will be created, 
and additional text may be entered.

To completely remove a line from the file, move the edit cursor to the line to be deleted, and 
simultaneously press CTRL and B.

To save the changes to the file on disk and then exit the program, press ESC, then press X.

To exit without saving any changes, press ESC, then press Q. Then type a Y to confirm the 
operation.
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2. SUMMARY OF ED COMMANDS

ESC X 

ESC Q 

CTRL B

DEL

BACKSPACE

Saves current text file with any changes to disk, and exits ED.

Exits ED without saving the current text file to disk.

Completely removes the current line from the text file, moving all lower 
lines up one position.

Deletes the character under the cursor.

Deletes the character to the left of the cursor.

UP Arrow Moves cursor up one text line.
DOWN Arrow Moves cursor down one text line.

LEFT Arrow Moves cursor one character to the left.
RIGHT Arrow Moves cursor one character to the right.

ESC SA/filename.txt Saves the current text file under the name "filename.txt".

3. EDITING THE SYSTEM STARTUP-SEQUENCE FILE

The Startup-Sequence is an ASCII text file containing a script of DOS commands that the system 
must execute as soon as the machine is powered on or after a system reset.

The commands listed in this file initialize several important system functions such as installing 
hard disk device drivers, setting up disk path aliases, and executing FastMemFirst to insure that 
programs load into Fast Memory.

Floppy Disk Users

To edit the Startup-Sequence file on a floppy boot disk, place the boot disk in drive DF1. Then 
type the following command from the Workbench CLI:

ED DF1:S/Startup-Sequence and press RETURN.

Hard Disk Users

To edit the Startup-Sequence file on a hard disk, enter the following command from the 
Workbench CLI:

ED Boot:S/Startup-Sequence and press RETURN.
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Adding Commands To The File

The following example places several ASSIGN commands at the end of the Startup-Sequence 
file. It illustrates how to enter the hard disk path aliases outlined in Appendix D : Advanced 
Hard Disk Configurations.

This example is intended for hard disk systems only, although it may be possible to extend the 
example to address other physical or virtual devices.

Press ESC, then press B. The edit cursor moves to the last line in the Startup-Sequence file.

Press RETURN one time to create a new blank line at the end of the file.

Enter the following lines in the file, pressing RETURN after each line.

Assign BTSEQ: Work:BTitler2
Assign BTFONT: Work:BTitler2
Assign BTPIC: Work:MY_PICTURE_FONT_DIR
Assign SOURCEFONT: Work:MY_AMIGA_FONT_DIR

Press ESC, then press "X" to save the file.

A  In the above example, you will need to substitute the names "MY_PICTURE_FONT_DIR" 
and "MY_AMIGA_FONT_DIR" with actual directory names used on your hard disk, i.e. 
"Woik:Graphics". If in doubt, you can simply use "Work:".
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Broadcast Titler’s Font Converter converts Amiga and Color Font format fonts into Broadcast 
Titler 2’s compressed format and adds extra Kerning and spacing information to the characters. 
However, it does not add anti-aliasing to the font. The Font Converter Program is provided on the 
Broadcast Titler 2 Program Disk. When formatting data disks, do not type "FONTS" to declare the 
name of the disk as it may confuse the system. Instead, use another name such as "BTFONTS".

Running the Font Converter

1. If you are going to save the converted Broadcast Titler 2 fonts onto a floppy disk, you will 
need to format a data disk before running the Font Converter program. A utility for formatting 
data disks is provided by pressing F5 in the Broadcast Titler’s Autoboot Menu.

2. Floppy disk users should first boot with the Broadcast Titler 2 program disk in floppy drive 
DFO. To run the Amiga Font to Broadcast Titler 2 Font Converter Program, double click on the 
"Converter" icon, or press F2 from the Autoboot Menu. In a moment, the Broadcast Titler Font 
Converter Main Menu will appear.

Inserting the Amiga Font Disk

3. (VERY IMPORTANT) As soon as the Main Menu appears, floppy disk users should insert 
the disk containing the AMIGA FONTS in drive DFO.

Finding the Amiga Fonts Directory

4. Wait for the disk to validate, and select the "COPY FONTS FROM" button at the top of the 
menu. The Disk Directory Menu appears.

The purpose of this menu is to locate the directory on the disk containing the Amiga Fonts to be 
converted. For most commercially available Amiga Fonts, this directory is "DFO:FONTS", 
which is the default name that appears in the DISK PATH button at the bottom of the menu.

If you see a ".Font" file in the directory list, then you have located the correct DISK PATH for 
the group of fonts on the disk. If you indeed have the correct DISK PATH, then your directory 
list should look something like this:

(Dir)MyFontl 
(Dir)MyFont2 
MyFontl .Font 
MyFont2.Font
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If you are loading fonts from a hard disk, or if the Amiga Fonts are in a different directory, select 
the appropriate DEVICE, and then select the appropriate Directory. Do this by selecting 
directory names from the Directory List, or type in the path from the keyboard and press 
RETURN.

A DO NOT actually select any of the ".Font" files or font directory names that appear in this list. 
Simply verify that the Directory List contains the font names you are looking for.

5. Select DONE, or click the Right Mouse Button to return to the Main Menu.

Setting the Font Destination

6. Locate the "COPY FONTS TO" button, and the disk path name below it. This path should 
indicate where you wish the resulting Broadcast Tider fonts to be saved.

Saving to a Floppy Disk

To save the converted Broadcast Tider fonts onto a floppy disk, insert the formatted data disk in 
your second disk drive now (if you only have one floppy disk drive, skip to step #7.)

If the "COPY FONTS TO" path is incorrect, then select "COPY FONTS TO", and select the 
desired DEVICE and directory path.

Saving to a Hard Disk

Select "COPY FONTS TO", and select the DEVICE and directory path on which you wish to 
save your Broadcast Tider fonts. For example, you may wish to save the fonts in the hard disk 
directory "FHl:BTider2". Click the Right Mouse Button to return to the Main Menu.

Selecting the Extended Character Set

7. Select "ASCII 128 (USA)" if you want to access special symbols, but do not need to type with 
special international accents. This option also saves space if the original Amiga Fonts contain all 
256 ASCH characters.

To convert all 256 characters in an Amiga Font defined with the full ASCII 256 international 
character set, select "ASCII 256INTL".

Converting a Font

8. Take a moment to verify the "COPY FONTS FROM" and "COPY FONTS TO" font path 
settings. If they are correct, click on the SELECT FONTS button.
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9. The AVAILABLE AMIGA FONTS Menu appears, listing the available Amiga fonts, along 
with their heights in scanlines. To view additional fonts in the list, click on the Up Arrow and 
Down Arrow buttons, or press the Up and Down Arrow keys from the keyboard.

10. Select the font you wish to convert into Broadcast Titler format. The Main Menu appears, 
and the selected font and size appears in the FONTS TO PROCESS list at the bottom of the 
menu.

11. To process multiple fonts, repeat the previous step to convert up to 11 fonts in a single batch. 
To delete a font from the batch list, select CLEAR LAST ENTRY.

12. Select CONVERT LIST. The Font Converter status screen appears. It indicates how many 
fonts and characters remain to be processed.

The conversion can take from about 2 to 10 minutes per font, depending on font size and the 
clock speed of the machine you are using.

The Font Converter works by scanning the font to add improved Kerning values to the font. It 
also compresses the font data so that the resulting font requires much less space on disk and in 
memory. For instance, a large 250 K Amiga Font file can be reduced to a 22 K Broadcast Titler 
Font, allowing many more fonts to be stored on-line in Broadcast Titler.

Each converted Broadcast Titler font is saved on disk as a ”.BTF", or Broadcast Titler Font file, 
which is recognized by Broadcast Titler.

When the conversion is complete, the Main Menu will reappear. Select QUIT to return to the 
Workbench or to the Autoboot menu.

A  Broadcast Titler and the Font Converter have built-in support for Color Fonts, so it is not 
necessary to run the Color Fonts utility "Color Text" required for most programs.

13. To load the resulting ".BTF" font files into Broadcast Titler, refer to the section "Loading 
Extra Fonts" contained in Chapter 10 : The File Menu.

A  Fonts converted with the Font Converter will not contain any anti-aliasing. You can achieve 
anti-aliasing and resizing of third party fonts by purchasing the optional Font Enhancer program 
for Broadcast Titler 2.
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Cable Information Channels often need to display information continuously, day and night, for 
weeks on end. It is imperative that such a system will automatically resume operation after an 
electrical power failure, without requiring any action from an operator.

The Broadcast Titler’s Demo Disk provided with the program is designed to be used for this 
purpose. To set up such a system using an Amiga 500,2000,2500 or 3000 series computer do 
the following:

1. Make a duplicate copy of your original Broadcast Titler Demo Disk. Store the original in a 
safe place.

2. Delete all of the ".BTF", ".BTS", and ".PICS" files from the copy of the Demo Disk. This 
clears the disk of the standard Broadcast Titler demo, along with its associated fonts and pictures.

3. Run Broadcast Titler. Load the sequence you wish to run. Place the copy of the Demo Disk 
in floppy disk drive DF0. Save the sequence on drive DF0, using the file name "AUTODEMO". 
To do this select SAVE SEQUENCE from the File Menu. Backspace over the name in the red 
Disk Path box, and type in "DF0: AUTODEMO" and press RETURN. The sequence will be 
saved under the name "DFO:AUTODEMO.BTS". Now exit Broadcast Tider.

4. Using the Workbench CLI or a file transfer utility, copy all fonts used in the sequence onto the 
copy of the Demo Disk.

The list of fonts that must be copied onto the disk is contained in the text file 
"AUTODEMO.LOAD", which was automatically saved on the Demo Disk in step 3 above. This 
file can be viewed in a standard text editor or word processor, and will indicate which font files 
must be copied.

5. Using the Workbench CLI or a file transfer utility, copy all pictures used in the sequence onto 
the Demo Disk. The list of pictures that must be copied onto the disk is contained in the text file 
"AUTODEMO.PICS", which was automatically saved on the Demo Disk in step 3 above. This 
file can also be viewed in a standard text editor or word processor.

6. The Demo Disk is now ready to go. Place the disk in floppy disk drive DF0 and reboot the
machine. The Demo Disk is set up to boot Workbench and then immediately start the Broadcast 
Titler Demo Player program whenever power is applied to the Amiga.
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The Demo Disk Player program is special in that it automatically loads a sequence file on the 
disk named "AUTODEMO.BTS", which in this case is the sequence saved on the disk in steps 3 
through 5 above.

After the sequence loads, it will be played and repeated continuously until power to the machine 
is turned off. As soon as the power comes back on again, the sequence will automatically load 
and play.

▲ If space on the Demo Disk is limited, a separate floppy disk containing just the font files used 
in the sequence can be placed in another disk drive, i.e. drive DF1. Broadcast Titler will look for 
fonts on drive DFO, and if a font is not found there it will look for the font on drive DF1 and then 
DF2. Placing the font (.BTF) files on a separate disk can save 200,000 bytes of disk space or 
more.

▲ If the memory expansion board used in the Amiga system is not auto-configuring, you may 
need to place an ADDMEM command line in the "Startup-sequence" file located in the "S" 
directory of the Demo Disk. This tells the system to recognize the extra memory as soon as the 
system is powered on.
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For this discussion it is assumed that Broadcast Titler has already been installed on a hard disk 
drive per the instructions in Chapter 2 of this manual.

When Broadcast Titler is installed on a hard disk, the program and its supporting files are copied 
into a directory named "BTider2". Depending on individual setup preferences, this directory can 
be located in any disk partition, and under any number of hierarchical subdirectories. The disk 
path leading to the BTitler2 directory could be as simple as "FHl:BTitler2", or it could as or 
more complex than "WORK:Graphics/Video/BTitler2".

To simplify the task of specifying lengthy directory path names, Broadcast Titler utilizes a set of 
path name aliases allocate specific file types on a disk.

MODIFYING THE STARTUP-SEQUENCE FILE

To accomplish this, one or more of the aliases "BTSEQ:", "BTFONT:", "BTPIC:" and 
"SourceFont:" must be assigned to actual hard disk path names. These path name "ASSIGN" 
commands are to be placed in the "Startup-Sequence" file found in the S directory of your hard 
disk boot partition. This is usually the file "Boot:S/Startup-Sequence".

As an example, the following command lines should be entered at the end of the 
"Startup-Sequence" file. (Refer to Appendix A: Using ED the System Text Editor, for 
information on editing text files.)

ASSIGN BTSEQ: FHl:BTitler2
ASSIGN BTFONT: FHl:BTitler2
ASSIGN BTPIC: FHl:Graphics/Paint/Hi-Res
ASSIGN SourceFont: FHl:AllMyAmigaFonts

The above ASSIGN commands are based on these assumptions:

Broadcast Titler has been installed in the directory "FHl:BTitler2". Broadcast Titler fonts are in 
the directory "FHl:BTitler2". IFF picture files are to be found in the directory 
"FHl:Graphics/Paint/Hi-Res". Amiga Fonts and Color Fonts in the directory 
"FHl:AllMyAmigaFonts". You may be using different directory names than these, so it will be 
necessary to change the path names used in the ASSIGN commands accordingly.

104



ADVANTAGES OF THIS CONFIGURATION

1. As already mentioned, it is easier enter the path name "BTPIC:" in Broadcast Tider’s Disk 
Directory Menu than to remember and enter the name "FH1 :Graphics/Paint/Hi-Res".

2. It provides a standard name for the location of specific file types for turn-key video systems.

3. Broadcast Titler automatically scans the system environment variable list, and if any of the 
alias names such as "BTPIC" are used, the Disk Directory Menu will default to the assigned 
directory for listing disk files of the specific file type.

Otherwise, the first time any Load or Save operation is used, the program will start listing files 
on drive DFO instead of the hard drive.

4. In Broadcast Tiller’s Disk Directory Menu, the correct directory containing the desired file 
types will automatically be listed.

The Load Picture function will list files from "BTPIC:".
The Load Sequence function will list files from "BTSEQ:".
The Load Font function will list files from "BTFONT:".

5. When using the Font Converter or the optional Font Enhancer, the "SourceFont:" alias is used 
to identify the source of the Amiga Fonts to be converted. This avoids the necessity of changing 
the system font variable "FONTS:" from its default setting at boot time, which is normally 
"Workbench:fonts".

The directory "Workbench:fonts" normally contains only the standard system fonts which are 
used within Workbench, text editors, etc. Most users install third party Amiga Fonts in their own 
directories in "Work:", or elsewhere on the disk.

Most of the time users are not concerned with the system fonts, they just want to access the 
additional video fonts they have purchased. This somewhat confusing distinction between sets 
of Amiga Font directories can be simplified by setting the desired Amiga Font at boot time via 
the assign variable"SourceFont:".
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A NOTE ON ANTI-ALIASING

The Amiga hardware produces a 70 nanosecond pixel resolution in the High Resolution graphics 
mode, the standard mode used in Broadcast Titler. At this resolution, stair-step edge patterns 
become apparent when the character face is placed against a dark background color. It is the 
sharp transition in contrast between the Face Color and the Background Color that makes the 70 
nanosecond stair-step patterns, or jaggies, become so apparent.

In order to improve the visual appearance of fonts, Broadcast Titler employs a four-step 
anti-aliasing ramp to sharpen the character edges by adding extra luminance information to the 
edges of the character. Broadcast Titler’s anti-aliasing is accomplished by generating a series of 
anti-alias color levels that range between the Character Outline Color and the Character Face 
Color.

To alleviate this problem, Broadcast Tider uses a Face to Oudine anti-alias spread to reduce this 
stair-stepping effect and to add additional definition to the character. This anti-aliasing principle 
is used in both the standard Broadcast Titler Fonts and the fonts converted with the optional Font 
Enhancer package, which converts 70 nanosecond Amiga fonts into Broadcast Tider’s 
anti-aliased format. The anti-aliased format yields an "effective resolution" of 23.3 nanoseconds. 
The difference between anti-aliased characters and non anti-aliased characters can be seen in the 
Font Menu by selecting the ANTI-ALIAS/STD HIRES option in the Font Menu.

CHANGING THE UNDERLINE COLOR

The character underline feature uses Color 4 as the underline color. To change the underline 
color on a particular line, enter the Palette Menu and select AFFECT LINE. To change the 
underline color for the entire page select AFFECT PAGE. Next select Color 4 and adjust the 
RGB or HS V color levels to create a new underline color. The Shadow for the underline is 
controlled by changing the Shadow color box labeled "SH".

PALETTE MENU OPERATION IN SUPER HI-RES MODE

The Amiga 3000 comes with a new version of the Denise video chip that doubles the Amiga’s 
resolution by providing a new 35 nanosecond "Super High Resolution" graphics mode. This 
doubles the Amiga’s shaipest resolution, from 70 nanoseconds to a broadcast quality 35 
nanoseconds.
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However as a trade-off for this improved resolution, the total number of colors that can be 
displayed on a page has been reduced from 16 colors per page to only 4 colors per page. For 
video, this represents 3 visible graphics colors plus keyed video.

The optional Broadcast Titler "Super-Hi Resolution Upgrade" takes advantage of this new 
resolution by using significantly sharper 35 nanosecond characters, and then adding Broadcast 
Titler’s anti-aliasing on top of that. This gives Broadcast Titler’s characters a truly professional 
look. In addition, Broadcast Titler’s line-by-line color palette change capability increases the 
maximum number of simultaneously displayable colors from only 4 per page to a total of 64 per 
page.

If a page of text contains a line of Super Hi-Res text, the Palette Menu displays the colors for the 
line with Color 0 on the far left, and the Shadow, Outline, and Face colors are shown on the for 
right side of the color boxes. The other colors in the palette will be blanked out so they cannot 
be selected.

Because of the rapid multiplexing required to achieve the new higher resolution, there is an 
additional limitation in the depth of the color palette for the Super High Resolution mode. The 
total number of colors available is reduced from 4,096 to only 64 colors. A palette of 64 colors 
is still plenty for most any application, the only difference is that there are not as many fine 
transitional steps between the colors as are available with the larger 4,096 palette.

The color sliders in the Palette Menu will work in much the same way as in the standard 16 color 
High Resolution mode. However, the granularity in color changes will be coarser for the Super 
High Resolution mode, ie. there are only four shades of Gray, four shades of pure Red, four 
shades of pure Blue, etc. But even with the limited number of Red, Green and Blue levels, the 
total palette of 64 colors still provides enough color variety to create highly attractive pages.

In the Super High Resolution mode, only one intermediate anti-alias value is used. With the 
combination of superior pixel resolution and anti-aliasing, the resulting characters are as sharp as 
virtually any high-end character generation system on the market. The "effective resolution" for 
this mode is 17 nanoseconds. InnoVision Technology highly commends Commodore for their 
ingenuity in bringing true broadcast quality resolution to the Amiga.

MIXING RESOLUTIONS ON A PAGE

Broadcast Titler allows Super High Resolution text lines to be placed just above or just below 
standard High 16 High color Resolution lines containing text or digitized 16 color IFF pictures. 
As you select lines with different resolutions in the Palette Menu, the appropriate palettes and 
number of colors will be displayed.
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MIXED RESOLUTION MULTIPLEXING ARTIFACT

If you are mixing High and Super High Resolutions on a page, you may notice a single scanline 
stripe pattern. This is due to the hardware multiplexing used in the Super High Resolution 
Mode. This pattern effect only involves Color Zero, the background color, and is not seen on the 
genlock video output. Again, this only occurs when you are actually mixing resolutions on a 
single page.

If necessary, this effect can be completely eliminated by setting the background Color 0 on the 
standard High Resolution line to full Black.

SELECTING THE BEST COLORS FOR VIDEO APPLICATIONS

The Amiga’s video color palette contains 4,096 colors. In RGB video, all of these colors appear 
sharp and without any distortion due to the high-bandwidth of RGB monitors. However in the 
domain of low-bandwidth NTSC video, some of the Amiga’s colors are unusable. This is 
because some color extremes are too saturated and too hot to be encoded in the color signal used 
by NTSC video.

Highly saturated, very bright colors can bleed, chroma crawl, or wash out in NTSC. Ideally, Black, 
White and Grays are the most stable colors to use for video graphics. As soon as bright computer­
generated colors are used, there can be color values which introduce undesirable side effects.

It is best to pick colors for video while viewing an actual NTSC monitor, since the 
aforementioned side effects will be readily visible and therefore easy to identify and correct. By 
selecting slightly different color values, it is often possible to improve or eliminate the 
undesirable visual effects produced by overly hot colors.

Some simple guidelines can prevent these effects by allowing you to identify and select colors 
that will produce good results when viewed on NTSC monitors. Colors that work best with 
NTSC are Black, White and shades of Gray, since these colors use almost exclusively the NTSC 
luminance signal which is the black and white TV signal. Since the computer is capable of 
generating very hot Reds, Blues, Greens , and Yellows, the NTSC equivalents of these colors 
will in many cases produce "invalid" or "illegal" colors.

One way of reducing these problems is to decrease the Saturation, or "S" level, of the brighter 
colors. Doing this adds white to the color, making it more quiet and subdued. In addition, colors 
that have a high Value (V level) are very bright, and in some cases are too hot for NTSC video.

In general it is best to select colors that have Saturation and Value levels that are at 
approximately 8 to 13 on the Broadcast Titler color slider scale. Colors which use Red, Green 
and Blue values above 12 or 13 tend to have more artifacting than colors composed of lesser 
RGB values. Remember to work with an NTSC monitor, because the color you see is the color 
you’ll get in your final output.
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USING HSV COLORS TO CREATE BACKGROUND COLOR 
BAR RAMPS

If you are not using a genlock, there are applications in which the background Color 0 can be 
used to create color bar backgrounds for each line of text. This is often used in Cable 
Information Display Channels to add interest to video bulletin boards.

The best color bar backgrounds are obtained by using colors that are similar in Hue and Value, 
blit differ from line to line in Saturation. Such a relationship gives a ramp of pastel colors. This 
concept has already been discussed in the Palette Menu section in Line Menu chapter.

Alternatively, the colors can be varied by Value or brightness, leaving the Hue and Saturation the 
same. This spread of colors ranges from Black through a spread of brighter shades.

Also interesting is a set of colors in which the Saturation and Value are the same, but the Hue is 
different for every line. This provides a very appealing set of rainbow colors.

Example:

To create the color bars in the Palette Menu, simply click on Color box 0, then select AFFECT 
PAGE. Create the brightest and most vivid color that you will be using. At this point, each line 
on the page will have the same background Color 0. Now select AFFECT LINE.

The next step is to change the color on each line progressing down the page. Click on the LINE 
DOWN box to bring the text cursor down to second line on the page. Adjust only one of the H,
S or V sliders to change the color. Repeat this process for each line going down the page, 
successively sliding the Saturation or Value slider a little farther for each line as you move down 
the page.

A If you are using a genlock, this pattern can also be created using a "Color 1 Background" 
pattern from the Line/Pattem Menu which fills the full page. Just change Color 1 on each line 
instead of Color 0.

TWO-TONE CHARACTERS

Additional special effects can be obtained by splitting text lines between two or more color 
windows. This is done by reducing the height of two or more windows so they cut across a single 
line of text. One color palette is displayed for the top half of the text line, and a second color 
palette is displayed for the bottom of the text line, giving a two-tone effect to the character face. 
See the Palette Menu section in the Line Menu chapter for details on changing color window 
heights.
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TEXT EDITING KEYS
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....................

DELETE LEFT CHARACTER 
DELETE RIGHT CHARACTER

EXIT TO EDIT MODE

CTRL
jciRL
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CTRL

MOVE CURSOR TO FIRST LINE ONPAGE 

MOVE CURSOR TO LAST LIFE ON PAGE 

MOVE CURSOR TO LAST CHARACTER ON LIFE 

MOVE CURSOR TO FIRST CHARACTER ON LINE

MOVE CURSOR UP ONE LIFE 

MOVE CURSOR DOWN O FE LIFE

J j  FINE TUNE CURSOR UP 
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LINE EDITING FUNCTIONS

CTRL COPY CURRENT LINE OF TEXT

C1RL PASTE CURRENT LINE OF TEXT

r  HIDE CURSORSn i i i i B rrrrn
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LEFT JUSTIFY TEXT 
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SHIFT

LINE EDITING FUNCTIONS
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PLAYBACK MODE SELECTION KEYS 
(Active in Play Menu and Main Menu)

□

PLAY CURRENT PACE 
= PLAY FROM CURRENT PAGE 

PLAY RANDOM PAGES 
PLAYKEYWAIT
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PLAYBACK CONTROL KEYS 
(Active During Playback)
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Insert
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Full Page 36 
Single Line 37 

Roll Effect 16
Tutorial 18

Save
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B R O A D C A S T  T IT L E R  2
BROADCAST QUALITY VIDEO CHARACTER GENERATOR

FOR THE AMIGA™

BREAKS THE AMIGA RESOLUTION BARRIER

Four-Level Anti-aliasing Eliminates "Jaggies" 
Includes 16 Anti-aliased Fonts -15 to 100 Scanlines High 

Mix Multiple Styles, Sizes and Colors on a Line 
Adjustable Border, Cast and Shadow in 8 Directions

DAZZLING COLORS

4,096 Color Palette, up to 320 Colors Per Page 
RGB and HSV Color Sliders for Easy Selection 
Displays IFF or Built-in Background Patterns 

Automatic Patterned Text Fill with IFF Brushes 
Color Effects include Flash, Fade and Color Cycling

ISUPER SMOOTH EFFECTS

Page Effects include Roll, Crawl, Comer, Push, Pull, Ease, Wipes,
Flip, Tumble, Date/Clock and many more 

Or Create Your Own Effects using Line-by-Line Transitions 
Playback Modes include Presentation, Loop, Random Access and GPI control 

Built-in SuperGen Genlock Dissolve Effects

SIMPLY AMAZING!

Convenient Mouse or Keyboard Operation 
Easy Editing lets you Reposition Text, Pick-Up and Drop Attributes 

Random Access for up to 600 Pages of Text and Graphics 
Loads Hundreds of Available Amiga and Color Fonts 

Stores up to 50 Resident Fonts On-line 
Supports Special Symbols and International Keymaps 

NTSC Overscan Display 736x480 - Eliminates Video Borders 
Not Copy Protected, Installs Easily on a Hard Disk

IHNOUISION
TECHNOLOGY

NTSC OVERSCAN VERSION 
Requires 512K CHIP RAM and 1 Megabyte FAST RAM 

Compatible with Workbench 2.0 and 1.3
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Amiga is a registered trademark o f  Commodore-Amiga. 
Specifications subject to change without notice
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